HP ProBook 450 G2 Notebook PC
/)  HP ProBook 455 G2 Notebook PC

Maintenance and Service Guide



© Copyright 2015 HP Development Company,
L.P.

AMD is a trademark of Advanced Micro Devices,
Inc. Bluetooth is a trademark owned by its
proprietor and used by HP Inc. under license.
Intel, Celeron, and Pentium are trademarks of
Intel Corporation in the U.S. and other
countries. Microsoft and Windows are
trademarks of the Microsoft group of
companies.

The information contained herein is subject to
change without notice. The only warranties for
HP products and services are set forth in the
express warranty statements accompanying
such products and services. Nothing herein
should be construed as constituting an
additional warranty. HP shall not be liable for
technical or editorial errors or omissions
contained herein.

Second Edition: August 2015
First Edition: June 2014

Document Part Number: 773257-002

Product notice

This user guide describes features that are
common to most models. Some features may
not be available on your computer.

Not all features are available in all editions of
Windows. This computer may require upgraded
and/or separately purchased hardware, drivers
and/or software to take full advantage of
Windows functionality. Go to
http://www.microsoft.com for details.

Software terms

By installing, copying, downloading, or
otherwise using any software product
preinstalled on this computer, you agree to be
bound by the terms of the HP End User License
Agreement (EULA). If you do not accept these
license terms, your sole remedy is to return the
entire unused product (hardware and software)
within 14 days for a full refund subject to the
refund policy of your seller.

For any further information or to request a full
refund of the price of the computer, please
contact your seller.

This computer may require upgraded and/ or
separately purchased hardware and/or a DVD
drive to install the Windows 7 software and
take full advantage of Windows 7 functionality.
See http://windows.microsoft.com/en-us/
windows7/get-know-windows-7 for details.



http://www.microsoft.com
http://windows.microsoft.com/en-us/ windows7/get-know-windows-7
http://windows.microsoft.com/en-us/ windows7/get-know-windows-7

Important Notice about Customer Self-Repair Parts

A CAUTION: Your computer includes Customer Self-Repair parts and parts that should only be accessed by an
authorized service provider. See Chapter 5, "Removal and replacement procedures for Customer Self-Repair
parts,” for details. Accessing parts described in Chapter 6, "Removal and replacement procedures for
Authorized Service Provider only parts," can damage the computer or void your warranty.
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Safety warning notice

A WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not place
the computer directly on your lap or obstruct the computer air vents. Use the computer only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface, such as
pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the skin or a soft
surface, such as pillows or rugs or clothing, during operation. The computer and the AC adapter comply with
the user-accessible surface temperature limits defined by the International Standard for Safety of
Information Technology Equipment (IEC 60950).
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1 Product description

Category

Description HP 450
UMA

HP 450
discrete

HP 455
UMA

HP 455
discrete

Product Name

HP ProBook 450 G2 Notebook PC v

v

HP ProBook 455 G2 Notebook PC

Processors

Intel® Core™ i7 processor, Haswell, Dual Core, 4th v
generation (4-MB L3 cache)

4510U, 2.0-GHz/3.1-GHz Core Turbo/Intel HD Graphics
4400

Intel® Core i5 processors, Haswell, Dual Core, 4th
generation (3-MB L3 cache)

4210U, 1.7-GHz/2.7-GHz Core Turbo processor/Intel HD
Graphics 4400

Intel Core i3 processors, Haswell, Dual Core, 4th
generation (3-MB L3 cache)

4030U, 1.9-GHz processor/Intel HD Graphics 4400
4005U, 1.7-GHz processor/Intel HD Graphics 4400

Intel Pentium processor, Haswell, Dual Core (2-MB L3
cache)

3558U, 1.7-GHz processor/Intel HD Graphics
Intel Celeron processor, Haswell (2-MB L3 cache)

2957U, 1.4-GHz processor/Intel HD Graphics

Intel Core i7 processor, Dual Core, 5th generation v
(1600MHz, 4-MB L3 cache, 15W, Intel HD 5500 Graphics)

5500U, 2.4-GHz/3.0-GHz Core Turbo

Intel Core i5 processor, Dual Core, 5th generation
(1600MHz, 3-MB L3 cache, 15W, Intel HD 5500 Graphics)

5200U, 2.2-GHz/2.7-GHz Core Turbo

Intel Core i3 processor, Dual Core, 5th generation
(1600MHz, 3-MB L3 cache, 15W, Intel HD 5500 Graphics)

5020U, 2.2-GHz
5015U, 2.1-GHz
5010U, 2.1-GHz
5005U, 2.0-GHz

Intel Pentium, Broadwell, Dual Core (1600MHz, 2-MB L3
cache, 15W, Intel HD Graphics)

3825U, 1.9-GHz
3805U, 1.9-GHz



Category Description HP 450 HP 450 HP 455 HP 455
UMA discrete UMA discrete

Intel Celeron, Broadwell, Dual Core (1600MHz, 2-MB L3
cache, 15W, Intel HD Graphics)

3215U, 1.7-GHz

3205U, 1.5-GHz

AMD processors v v

AMD FX-7500,Quad Cores, 3.3 GHz/2.1 GHz, 2 MB L2
cache/Radeon™ R7 graphics

AMD A10-7300, Quad Cores, 3.2 GHz/1.9 GHz 2 MB L2
cache/Radeon R7 graphics

AMD A8-7100, Quad Cores, 3.0 GHz/1.8 GHz 2 MB L2
cache/Radeon R6 graphics

AMD A6 Pro-7050B, Dual Cores, 3.0 GHz/2.2 GHz 1 MB L2
cache/Radeon R5 graphics

Chipset Integrated with processor v v
AMD A76M FCH v v
Graphics Integrated UMA: v v

See processor category.

Switchable discrete (Intel processors): v

AMD Radeon R5 M255 with 2 GB or 1 GB dedicated video
memory

Switchable discrete (AMD processors): v

FX series APU - Graphic Branding AMD Radeon R7
M265DX with 2 GB of dedicated video memory

A10 series APU - Graphic Branding AMD Radeon R7
M260DX with 2 GB of dedicated video memory

A8 series APU - Graphic Branding AMD Radeon R6
M255DX with 2 GB of dedicated video memory

A6 series APU - Graphic Branding AMD Radeon R5 M255
with 2 GB of dedicated video memory

Supports HD decode, DX11, HDMI v v v v

Supports PX5 v

Supports PX7 v v
Panel eDP -flat v v v v

39.6-cm (15.6-inch) HD, 1366x768, 200 nits, 3.8 mm, 1

or 2 WLAN antennas

39.6-cm (15.6-inch) HD, 1366x768, 200 nits, 3.8 mm, 1 v v

or 2 WLAN antennas, camera

39.6-cm (15.6-inch) HD, 1366x768, 200 nits, 3.8 mm, 1 v v
or 2 WLAN antennas, camera, WWAN
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Category Description HP 450 HP 450 HP 455 HP 455
UMA discrete UMA discrete
39.6-cm (15.6-inch) HD, 1366x768, 200 nits, 3.8 mm, v v
touch panel, 1 or 2 WLAN antennas, camera (supported
on UMA and 1 GB discrete graphics models only)
eDP -slim v v
39.6-cm (15.6-inch) HD, 1920x1080, 300 nits, 3.2 mm, 1
or 2 WLAN antennas
39.6-cm (15.6-inch) HD, 1920x1080, 300 nits, 3.2 mm, 1 v v
or 2 WLAN antennas, camera
39.6-cm (15.6-inch) HD, 1920x1080, 300 nits, 3.2 mm, 1 v v
or 2 WLAN antennas, WWAN, camera
All display assemblies include 1 or 2 wireless local area v v
network (WLAN) antennas
Display assemblies include 2 worldwide 5-band (WWAN) v
antennas
Memory Two customer-accessible memory module slots v v v v
supporting up to 16 GB of RAM
Supports dual-channel memory v v v v
PC3L-12800, 1600-MHz, DDR3L SODIMMs v v v v
Supports the following configurations: v v v v
e 16384 MB (8192 x 2; dual channel)
e 12288 MB (8192 + 4096; dual channel)
° 8192 MB (8192 x 1)
e 8192 MB (4096 x 2; dual channel)
e 6144 MB (4096 + 2048; dual channel)
e 4096 MB (4096 x 1)
e 2048 MB (2048 x 1)
Primary storage Supports 7-mm/9.5-mm, 2.5-in SATA hard drives with HP v v v v
3D DriveGuard
Customer-accessible v v v v
Supports the following drives: v v

e  1.5-TB, 5400-rpm

° 1-TB, 5400-rpm

e  750-GB, 7200-rpm

° 750-GB, 5400-rpm

. 500-GB, 7200-rpm

e  500-GB, 5400-rpm

e  500-GB, 5400-rpm, hybrid (8-GB SSD) MLC
e  320-GB, 5400-rpm

e  256-GB Solid-state drive (SSD), TLC
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Category Description HP 450 HP 450 HP 455 HP 455
UMA discrete UMA discrete
e  128-GB Solid-state drive (SSD)
e  128-GB Solid-state drive (SSD), TLC
Supports the following drives: v v
° 1.5-TB, 5400-rpm
° 1-TB, 5400-rpm
° 750-GB, 5400-rpm
° 500-GB, 7200-rpm
° 500-GB, 5400-rpm
(] 320-GB, 5400-rpm
e  128-GB Solid-state drive (SSD)
Mini-card SSD M.2 2242 SSD v v
120GB
Set as primary storage if selected. Not available with
Celeron or Pentium processors. Not available with WWAN.
Fixed optical drives Supports the following 9.5-mm SATA optical drives: v v v v
e  DVD-ROM
e  DVD+/-RW SuperMulti DL
Blu-ray ROM DVD+/-RW SuperMulti DL v v
Supports no optical drive option v v v v
Audio/Visual Integrated camera (720p HD) v v v v
Stereo speakers (2) v v v v
Integrated dual-array microphone (webcam models only) v v v v
Integrated mono microphone (non-webcam models only) v v
Headphone/microphone combo jack v v v v
Realtek ALC3227-CG v v v v
Skype-ready v v v v
HD audio with DTS Sound+ v v v v
Supports “no camera” option v v v
Ethernet Realtek RTL8161GSH-CG 10/100/1000 v v v v
53/54/S5 wake on LAN (AC mode and battery mode) v v v v
NIC power down technology v v v v
Ethernet cable not included v v v v
Wireless Integrated WLAN options by way of wireless module: v v v v
WLAN antennas built into display assembly v v v v
Supports “no WLAN/Bluetooth” option v v v v
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Category Description HP 450 HP 450 HP 455 HP 455
UMA discrete UMA discrete
Integrated WLAN options via Minicard: v v v v
e  QCA802.11 b/g/n 1x1 (Marilyn) Backup
e  Broadcom 802.11 a/b/g/n 2x2 +BT Combo
(Bumblebee) w/o WiDi
e  Broadcom 802.11 b/g/n 1x1 +BT Combo (Harrier)
Backup
e  Realtek 802.11 b/g/n 1x1 (Focus)
e  Realtek 802.11 b/g/n 1x1 +BT Combo (Skyray)
Supports the following WLAN formats: v v
e Intel 802.11 a/b/g/n/AC 2x2 +BT Combo (Wilkins
Peak 2) - no vPro
e Intel 802.11 a/b/g/n/AC 1x1 +BT Combo (Wilkins
Peak 1)
Wireless Personal Area Network (PAN) only supported v v v v
by Bluetooth 4.0 combo card
Integrated WWAN options by way of wireless module:
Two WWAN antennas built into display assembly (world- v
wide 5 band, configured with panels)
Subscriber identity module (SIM) security (customer- v
accessible)
Supports “no WWAN” option v
Supports the following WWAN modules: v
e  HPhs3110 HSPA+ Mobile Broadband Module
° HP [t4112 LTE/HSPA+ Gobi 4G Module
External media card Digital Media Reader Slot v v v v
Supports SD, SDHC, SDXC
Ports Headphone/Microphone Combo Jack v v v v
RJ-45 (Ethernet, includes link and activity lights) v v v v
USB 3.0 (2) v v v v
USB 2.0 (2) v v v v
VGA (Dsub 15-pin) supporting 2048 x 1536 external v v
resolution at 50-GHz (hot plug/unplug with auto-detect)
VGA (Dsub 15-pin) supporting 1920 x 1200 external v v
resolution at 60-GHz (hot plug/unplug with auto-detect)
HDMI 1.4 v v v v
Multi-pin AC port v v v v
Keyboard/pointing Full-sized, chiclet, spill-resistant keyboard with numeric v v v v

devices

keypad
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Category Description HP 450 HP 450 HP 455 HP 455
UMA discrete UMA discrete

Backlit, full-sized, chiclet, spill-resistant keyboard with v v v v
numeric keypad
Touchpad includes: on/off button on board; 2-way scroll v v v v
with legend, taps enabled by default, 2-finger scrolling
and zoom enabled by default

Power requirements 90-W Smart AC adapter with localized cable plug support v
(3-wire plug with ground pin)
65-W Smart AC adapter with localized cable plug support v v
(3-wire plug with ground pin)
45-W Smart AC adapter with localized cable plug support v v
(3-wire plug with ground pin)
45-W AC adapter (2-prong) v v v v
Power cord: 3-wire plug-1.8 mor 1.0 m v v v v
Power cord: 2-wire plug-1.0m
4-cell, 44-Wh, 3.0 Ah, Li-ion battery v v v v
4-cell, 40-Wh, 3.0 Ah, Li-ion battery (long life) v v v v

Security Integrated fingerprint reader v v v v
No fingerprint reader option
Security lock
TPM SLB9660 (FW ver. 1.2) (Infineon; soldered down)
TPM support

Operating system Preinstalled:
Windows 7 Professional 64 v v v v
Windows 7 Home Premium 64 v v v v
Windows 7 Home Basic 64 v v v v
Windows 8.1 Professional 64-bit Digital Product Key v v v v
(DPK) with Windows 7 Professional 64
Windows 8.1 Professional 64-bit Digital Product Key v v v v
(DPK) with Windows 7 Professional 64 — MSNA
Windows 8.1 China (CH) 64-bit v v v v
Windows 8.1 Emerging Markets (EM) 64-bit v v v v
Windows 8.1 Multi-language (ML) 64-bit v v v v
Windows 8.1 Professional 64-bit v v v v
Windows 8.1 Professional 64-bit — MSNA v v v v
Windows 10 Home 64 v v v v
Windows 10 Home 64 — StF MSNA for Higher Education v v v v
Windows 10 Home 64 Single Language v v v v
Windows 10 Home 64 Chinese Market v v
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Category Description HP 450 HP 450 HP 455 HP 455
UMA discrete UMA discrete

Windows 10 Home 64 Chinese Market — CPPP v v
Windows 10 Home 64 High-end v v v v
Windows 10 Home 64 High-end Single Language v v v v
Windows 10 Home 64 High-end Chinese Market v v
Windows 10 Professional 64 v v v v
Windows 10 Professional 64 — StF MSNA EM v v v v
Windows 10 Professional 64 Downgrade Windows 7 32 v v
Windows 10 Professional 64 Downgrade Windows 7 64 v v v v
Windows 10 Professional 64 Downgrade Windows 7 64 — v v v v
StF MSNA EM
FreeDOS 2.0 v v v v
Ubuntu Linux v v v v
Restore Media (DRDVD/SRDVD):
DRDVD Windows 10 v v v v
DRDVD Windows 8.1 v v v v
DRDVD Windows 7 v v v v
SRDVD Ubuntu Linux v v v v
Restore Media (0SDVD):
Windows 7 Home Basic 64 v v v v
Windows 7 Home Premium 64 v v v v
Windows 7 Professional 32 v v v v
Windows 7 Professional 64 v v v v
Windows 8.1 Professional 64 v v v v
Windows 8.1 64-bit v v v v
Windows 8.1 Country Specific 64-Bit v v v v
Windows 8.1 Emerging Market 64-Bit v v v v
Windows 10 0SDVD Downgrade RTF v v
Web-only support:
Windows 7 Professional 32 v v v v
Windows 7 Enterprise 64 v v v v
Windows 7 Enterprise 32 v v v v
Windows 8.1 Enterprise 64 v v v v
Windows 10 Enterprise v v v v

Certified:
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Category Description HP 450 HP 450 HP 455 HP 455
UMA discrete UMA discrete
Microsoft WHQL v v v v
Serviceability End-user replaceable parts:
AC adapter v v v v
Battery (system) v v v v
Hard drive v v v v
Memory module v v v v
Optical drive v v v v
WLAN module v v v v
WWAN module v
Keyboard v v v Vv
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2 External component identification

Display

Component Description

(1) WLAN antennas (2)* (select models only) Send and receive wireless signals to communicate with wireless local
area networks (WLAN).

2 WWAN antennas (2)* (select models only) Send and receive wireless signals to communicate with wireless wide
area networks (WWAN).

(3) Internal microphones (2) (select models only) Record sound.

(4) Webcam light (select models only) On: The webcam is in use.

(5) Webcam (select models only) Records video and captures photographs. Some models allow you to
video conference and chat online using streaming video.
To use the webcam:
Windows 7: Select Start > All Programs > Communication and Chat
> CyberLink YouCam.
Windows 8.1: Access HP Support Assistant. To access HP Support
Assistant, from the Start screen, select the HP Support Assistant
app.
Windows 10: Type camera in the taskbar search box, and then
select Camera.

(6) Internal display switch Turns off the display or initiates Sleep if the display is closed while

the power is on.

Display



Component Description

NOTE: The display switch is not visible from the outside of the
computer.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around the
antennas free from obstructions. For wireless regulatory notices, see the section of the Regulatory, Safety, and Environmental Notices
that applies to your country or region. To access this guide:

Windows 7: Select Start > Help and Support > User Guides.
Windows 8.1: From the Start screen, type support, and then select the HP Support Assistant app.

Windows 10: Select Start, select All apps, select HP Help and Support, and then select HP Documentation.

Top
TouchPad

P 1

\ p o

Component Description
(1) TouchPad on/off button Turns the TouchPad on and off.
(2) TouchPad zone Moves the pointer and selects or activates items on the screen.

NOTE: The TouchPad also supports edge-swipe gestures.

3) Left TouchPad button Functions like the left button on an external mouse.

(a) Right TouchPad button Functions like the right button on an external mouse.
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Lights
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Component Description
(1) l Power light e  On: The computer is on.

0 e  Blinking: The computer is in the Sleep state, a power-saving
state. The computer shuts off power to the display and
other unneeded components.

e  Off: The computer is off or in Hibernation. Hibernation is a
power-saving state that uses the least amount of power.
(2) Caps lock light On: Caps lock is on, which switches the keys to all capital letters.

3) l:ll:l'ﬂ Microphone mute light e  Amber: microphone sound is off.
e  Off: microphone sound is on.
(4) Num lock light On: Num lock is on.
(5) Wireless light White: An integrated wireless device, such as a wireless local area

network (WLAN) device and/or a Bluetooth® device, is on.

NOTE: Onsome models, the wireless light is amber when all
wireless devices are off.

(6) Speaker mute light
[

e  Amber: Computer sound is off.

e  White: Computer sound is on.

(7) TouchPad light

e  Amber: The TouchPad is off.

e  Off: The TouchPad is on.

Top 11



Buttons, speakers, and fingerprint reader (select models only)

12

[%9 NOTE: Refer to theillustration that most closely matches your computer.
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Component Description
(1) Power button e When the computer is off, press the button to turn on the

0
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computer.

e  When the computer is on, press the button briefly to initiate
Sleep.

e  When the computer is in the Sleep state, press the button
briefly to exit Sleep.

e When the computer is in Hibernation, press the button
briefly to exit Hibernation.

CAUTION: Pressing and holding down the power button will
result in the loss of unsaved information.

If the computer has stopped responding and Windows® shutdown
procedures are ineffective, press and hold the power button for at
least 5 seconds to turn off the computer.

To learn more about your power settings, see your power
options:

Windows 7: Select Start > Control Panel > System and Security
> Power Options.

Windows 8.1: From the Start screen, type power, select Power
and sleep settings, and then select Power and sleep from the
list of applications.

Windows 10: Type power in the taskbar search box, and then
select Power and sleep settings.



Keys

Component Description

—or-

Right-click the Start button, and then select Power Options.
(2 Speakers (2) Produce sound.
(3) Wireless button Turns the wireless feature on or off but does not establish a

hIﬂ

wireless connection.

G))

Speaker mute button

Mutes and restores speaker sound.

(5)

Fingerprint reader (select models only)

Allows a fingerprint logon to Windows, instead of a password
logon.

Component Description

(1) esc key Displays system information when pressed in combination with
the fn key.

2) fn key Executes frequently used system functions when pressed in
combination with a function key, the num Lk key, or the esc key.

(3) - Windows key Windows 7: Displays the Windows Start menu.

nm

Windows 8.1: Returns you to the Start screen from an open app
or the Windows desktop.
NOTE: Pressing the Windows key again will return you to the
previous screen.
Windows 10: Opens the Windows Start menu.
NOTE: Pressing the Windows key again will close the Start
menu.

(@) Function keys Execute frequently used system functions when pressed in

combination with the fn key.
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Component Description

(5) num Lk key Alternates between the navigational and numeric functions on
the integrated numeric keypad.

(6) Integrated numeric keypad When num Lk has been enabled, it can be used like an external
numeric keypad.

Bottom

[%r NOTE: Refer to theillustration that most closely matches your computer.

©® @ @

Component Description

(1) Vents (2) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(2) Service door Provides access to the hard drive bay and the memory
" module slots.

3) n Battery release latch Releases the battery.
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Component

Description

J‘ Battery lock latch

Locks the battery in the battery bay.

4) Service door

Provides access to the wireless LAN (WLAN) module slot,
the WWAN module slot, and SIM slot.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore computer
functionality, and then contact support through HP
Support Assistant.

To access Help and Support in Windows 7: Select Start >
Help and Support.

To access HP Support Assistant: in Windows 8.1: From the
Start screen, select the HP Support Assistant app.

Windows 10:

Type support in the taskbar search box, and then select
the HP Support Assistant app.

-or-

Click the question mark icon in the taskbar.

(5) Battery bay

Holds the battery.

(6) E SIM slot

Supports a wireless subscriber identity module (SIM). The
SIM slot is located under the service door.

Front

00 -
Component Description
(1) = Hard drive light e  Blinking white: The hard drive is being accessed.
H e Amber: HP 3D DriveGuard has temporarily parked the
hard drive.
(2) Memory card reader Reads optional memory cards that store, manage, share,

or access information.

Front

15
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Left

Component

Description

(1

Q

Power connector

Connects an AC adapter.

()

AC adapter/Battery light

e  White: The computer is connected to external power and
the battery is charged from 90 to 99 percent.

° Amber: The computer is connected to external power and
the battery is charged from 0 to 89 percent.

e  Off: The battery is fully charged.

(3)

Vent

Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal for
the internal fan to cycle on and off during routine operation.

(4)

()

External monitor port

Connects an external VGA monitor or projector.

(5)

RJ-45 (network) jack/lights

Connects a network cable.
e Green (right): The network is connected.

e  Amber (left): Activity is occurring on the network.

(6)

HDMI port

Connects an optional video or audio device, such as a high-
definition television, any compatible digital or audio component,
or a high-speed HDMI device.

(7

USB 3.0 ports (2)

Each USB 3.0 port connects an optional USB device, suchas a
keyboard, mouse, external drive, printer, scanner or USB hub.
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Component

Description

(1

O

Audio-out (headphone)/Audio-in (microphone)
jack

Connects optional powered stereo speakers, headphones,
earbuds, or a headset. Also connects an optional headset
microphone. This jack does not support optional microphone-
only devices.

WARNING! To reduce the risk of personal injury, adjust the
volume before putting on headphones, earbuds, or a headset.
For additional safety information, see the Regulatory, Safety,
and Environmental Notices.

To access this document:

Windows 7:

Select Start > Help and Support > User Guides.
Windows 8.1:

From the Start screen, type support, and then select the HP
Support Assistant app.

—or—

From the Windows desktop, click the question mark icon in the
notification area, at the far right of the taskbar.

Windows 10:

Select Start, select All apps, select HP Help and Support, and
then select HP Documentation.

NOTE: When a device is connected to the jack, the computer
speakers are disabled.

NOTE: Be sure that the device cable has a 4-conductor
connector that supports both audio-out (headphone) and
audio-in (microphone).

(2) USB 2.0 ports (2) Connects an optional USB device, such as a keyboard, mouse,
e external drive, printer, scanner or USB hub.
3) Optical drive (select models only) Depending on your computer model, reads an optical disc or
reads and writes to an optical disc.
(4) Optical drive eject button (select models only) Releases the optical drive disc tray.
(5) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but
it may not prevent the computer from being mishandled or
stolen.

Right

17
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Labels

The labels affixed to the computer provide information you may need when you troubleshoot system
problems or travel internationally with the computer.

[ IMPORTANT: Check the following locations for the labels described in this section: the bottom of the
computer, inside the battery bay, under the service door, or on the back of the display.

Service label—Provides important information to identify your computer. When contacting support, you
will probably be asked for the serial number, and possibly for the product number or the model number.
Locate these numbers before you contact support.

Your service label will resemble one of the examples shown below. Refer to the illustration that most
closely matches the service label on your computer.

| & HO0ODO0O
Serial J0000CCOC_ MR MENARNMANNN |

Pradud: 00000000 mEnmImnnInnn
Warranty: 1yl
1 Madel: X00000C

ICserial._xoo00ooc INILNITTETNIN
wrorr ooy |INNAEMWIWENEIN

Wl OO

Rt 00 OCE P I 0000 00000 DO G0
L UM T

Component

(1) Serial number

(2)  Product number

3) Warranty period

(4)  Model number (select products only)

o_

e

HPF Long Model Hame
— Pl A00OOC0 XK
ShE X0 OO0
——Warranty 1ylyOy

Component

(1) Model name (select products only)

(2)  Product number

(3)  Serial number

(@)  Warranty period

Regulatory label(s)—Provide(s) regulatory information about the computer.

Wireless certification label(s)—Provide(s) information about optional wireless devices and the approval
markings for the countries or regions in which the devices have been approved for use.
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3 Ilustrated parts catalog

Computer major components

[%? NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and then
follow the on-screen instructions.

[%’/f‘ NOTE: Details about your computer, including model, serial number, product key, and length of warranty,
are on the service tag at the bottom of your computer. See Labels on page 18 for details.
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Item Description Spare part number

(1 Display panel, 39.6-cm (15.6-inch), HD, anti-glare, touch screen not spared
Includes one WLAN antenna 782121-001
Includes two WLAN antennas 782122-001
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Item Description Spare part number
(2) Keyboard (includes cable)
NOTE: For a detailed list of keyboard country codes, see Keyboard on page 49.
Backlit 768130-xxx
No backlight 768787-xxx
3) Top cover (includes touchpad assembly) 768139-001
(4) Touchpad button board 768140-001
(5) Power button board assembly 767442-001
(6) Card reader board
For use in HP 450 models 768133-001
For use in HP 455 models 780894-001
(7 Function board 768131-001
(8) Fingerprint reader assembly (includes cable, bracket, and bezel) 768128-001
9) System board (includes replacement thermal material)
All system boards use the following part numbers:
xxxXxx-001: Windows 7 or non-Windows operating systems
xxxxxx-501: Windows 8.1 Standard operating system
xxxxxx-601: Windows 8.1 or Windows 10 operating system
Intel i7-5500U processor; 2-GB discrete graphics memory 799562-xxx
Intel i7-5500U processor; UMA graphics memory; no WWAN models 799553-xxx
Intel i7-5500U processor; UMA graphics memory; WWAN models 799555-xxx
Intel i5-5200U processor; 2-GB discrete graphics memory 799561-xxx
Intel i5-5200U processor; 1-GB discrete graphics memory 799558-xxx
Intel i5-5200U processor; UMA graphics memory; no WWAN models 779552-xxx
Intel i5-5200U processor; UMA graphics memory; WWAN models 799554-xxx
Intel i3-5020U processor; 2-GB discrete graphics memory 824133-xxx
Intel i3-5020U processor; 1-GB discrete graphics memory 824132-xxx
Intel i3-5020U processor; UMA graphics memory; no WWAN models 824129-xxx
Intel i3-5010U processor; 2-GB discrete graphics memory 799560-xxx
Intel i3-5010U processor; 1-GB discrete graphics memory 799557-xxx
Intel i3-5010U processor; UMA graphics memory; no WWAN models 799551-xxx
Intel i3-5005U processor; 2-GB discrete graphics memory 799559-xxx
Intel i3-5005U processor; 1-GB discrete graphics memory 779556-xxx
Intel i3-5005U processor; UMA graphics memory; no WWAN models 799550-xxx
Intel i7-4510U processor; 2-GB discrete graphics memory 768145-xxx

Computer major components
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Item Description Spare part number
Intel i7-4510U processor; UMA graphics memory; non-WWAN models 768148-xxx
Intel i7-4510U processor; UMA graphics memory, WWAN models 784653-xxx
Intel i5-4210U processor; 2-GB discrete graphics memory 768143-xxx
Intel i5-4210U processor; 1-GB discrete graphics memory 768142-xxx
Intel i5-4210U processor; UMA graphics memory; WWAN models 784652-xxx
Intel i3-4030U processor; 2-GB discrete graphics memory 782950-xxx
Intel i3-4030U processor; UMA graphics memory 782952-xxx
Intel i3-4005U processor; UMA graphics memory 782951-xxx
Intel i5-4210U processor; UMA graphics memory 768146-xxx
Intel Pentium 3825U processor; UMA graphics memory 824130-xxx
Intel Pentium 3805U processor; UMA graphics memory 799549-xxx
Intel Pentium 3558U processor; UMA graphics memory 768150-xxx
Intel Celeron 3215U processor; UMA graphics memory 824128-xxx
Intel Celeron 3205U processor; UMA graphics memory 799548-xxx
AMD FX-7500 processor; 1 GB discrete graphics memory 773080-xxx
AMD A10-7300 processor; 2 GB discrete graphics memory 773079-xxx
AMD A8-7100 processor; 2 GB discrete graphics memory 773078-xxx
AMD A6-7000B processor; 2 GB discrete graphics memory 773077-xxx
AMD A10-7300 processor; UMA graphics memory 773075-xxx
AMD A8-7100 processor; UMA graphics memory 773074-xxx
AMD A6-7050B processor; UMA graphics memory 773073-xxx
(10 USB/audio board 768132-001
(11) Memory modules (PC3L-12800, 1600-MHz, DDR3L)
8-GB 693374-001
4-GB 691740-001
2-GB 691739-001
(12) Optical drive extension board not spared
(13) WWAN module
HP [t4112 LTE/HSPA+ Gobi 4G Module 740011-001
HP hs3110 HSPA+ Mobile Broadband Module 748599-001
(14) RTC battery 738824-001
(15) WLAN module
Atheros AR9485 802.11b/g/n 1x1 WiFi Adapter 675794-001
Realtek RTL8188EE 802.11bgn Wi-Fi Adapter 709848-001
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Item Description Spare part number
Intel Dual Band Wireless-AC 3160 802.11 ac 1x1 WiFi + BT 4.0 combo adapter 710662-001
Broadcom BCM943228HMB 802.11abgn 2x2 Wi-Fi Adapter + Broadcom Bluetooth 4.0 Adapter 730668-001
Broadcom BCM43142 802.11 bgn 1x1 Wi-Fi + BT4.0 HMC combo adapter 753076-001
Realtek RT8723BE 802.11 bgn 1x1 Wi-Fi + BT4.0 combo adapter 753077-001

Intel Dual Band Wireless-AC 7260 802.11 ac 2x2 WiFi + Intel Dual Band Wireless-AC 7260 BT 4.0 756753-001

combo adapter

Heat sink assembly (includes replacement thermal material)

(16) For use in HP 450 (Intel) models with discrete graphics and all processors except for the Intel 768050-001
i7-4558U
For use in HP 450 (Intel) models with discrete graphics and an Intel i7-4558U processor 768049-001
(17) For use in HP 450 (Intel) models with UMA graphics 768048-001
For use in HP 455 models (AMD) with UMA graphics 767435-001
For use in HP 455 models (AMD) with discrete graphics 767434-001
(18) Power connector and cable 767432-001
(19) Fan 767433-001
(20) Speaker assembly 768138-001
(21) Battery, Li-ion
4-cell, 44 WHr, 3.0 Ah 756744-001
4-cell, 40 WHr, 3.0 Ah 756746-001
(22) Base enclosure
For use in models with Haswell processors 768124-001
For use in models with Broadwell processors 809421-001
Service doors, includes: 768134-001
(23) Small service door
(24) Large service door
(25) Hard drive
1.5-TB, 5400-rpm, 9.5 mm 747375-001
750-GB, 5400-rpm, 778190-001
750-GB, 7200-rpm (HP 450 model only) 778191-001
500-GB, 7200-rpm 778189-001
500-GB, 5400-rpm, 7 mm 778186-001
500-GB, 5400-rpm, 7 mm, hybrid (8-GB SSD) 732000-001
320-GB, 5400-rpm 645088-001
Solid-state drive
256-GB Solid-state drive, TLC, for use in HP 450 models 817630-001

Computer major components
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Item Description Spare part number
128-GB Solid-state drive, TLC, for use in HP 450 and HP 455 models 822214-001
128-GB Solid-state drive for use in HP 450 models 778175-001
128-GB Solid-state drive for use in HP 455 models 773069-001
120-GB Solid-state drive, M.2, for use in HP 450 models 768469-001
(26) Optical drive (includes bracket, bezel, and screws)
HP 450 models:
° Blu-ray ROM DVD+RW SuperMulti DL Drive 768472-001
° DVD+RW SuperMulti DL Drive 768471-001
e  DVD-ROM drive 768470-001
HP 455 models:
° DVD+RW SuperMulti DL Drive 773071-001
° DVD-ROM drive 773070-001
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Display components
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49.

Item Description Spare part number
(1) Display bezel
For use in models with a webcam 768125-001
For use in models without a webcam 768126-001
(2 Webcam module
HD 767457-001
HD, Lync 807958-001
Microphone module 773563-001
3) Display panel (raw)

Display components
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Item Description Spare part number
Flat, HD, for use in HP 450 models 768135-001
Slim, FHD, for use in HP 450 models 768468-001
Flat, HD, for use in HP 455 models 773072-001

(4) WLAN antennas not spared separately
Included in Display Rear Cover kit, 768123-001
(5) WWAN antennas not spared separately
Included in Display Rear Cover kit, 768123-001
(6) Display Hinge Kit (includes left and right hinges) 768129-001
(7) Display/webcam cable assembly 768127-001
(in Cable Kit)
(8) Display rear cover (includes wireless antennas) 768123-001

Cable Kit

Item Description Spare part number
Cable Kit 768127-001

1 Battery connector cable

(2) Display/webcam cable

(3) Display/webcam cable, EDP

26  Chapter 3 lllustrated parts catalog



Mass storage devices

Description Spare part number
Hard drives

1.5-TB, 5400-rpm, 9.5 mm 747375-001
750-GB, 7200-rpm (HP 450 model only) 778190-001
750-GB, 5400-rpm 778191-001
500-GB, 7200-rpm 778189-001
500-GB, 5400-rpm 778186-001
500-GB, 5400-rpm, 7 mm, hybrid (8-GB SSD) 732000-001
320-GB, 5400-rpm 645088-001

Solid-state drives

256-GB Solid-state drive, TLC, for use in HP 450 models 817630-001
128-GB Solid-state drive, TLC, for use in HP 450 and HP 455 models 822214-001
128-GB Solid-state drive for use in HP 450 models 778175-001
128-GB Solid-state drive for use in HP 455 models 773069-001
120-GB Solid-state drive, M.2, for use in HP 450 models 768469-001
Hard Drive Hardware Kit (includes hard drive bracket and screws; not illustrated) 767437-001

Optical drives (include bezel, bracket, and screws)

For use in HP 450 models

° Blu-ray ROM DVD+RW SuperMulti DL Drive 768472-001
° DVD+RW SuperMulti DL Drive 768471-001
e  DVD-ROM drive 768470-001

For use in HP 455 models

° DVD+RW SuperMulti DL Drive 773071-001

e  DVD-ROM drive 773070-001
Miscellaneous parts

Description Spare part number

AC adapters

65-W AC adapter 693711-001

65-W AC adapter for use in India 693710-001

45-W AC adapter, 2-prong 742437-001

45-W AC adapter, non-slim 744893-001

Power cords, 1.83 m, 3-pin:
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Description Spare part number
For use in Argentina 490371-D01
For use in Australia 490371-011
For use in Denmark 490371-081
For use in Europe, the Middle East, and Africa 490371-021
For use in India 490371-D61
For use in Israel 490371-BB1
For use in Italy 490371-061
For use in Japan 490371-291
For use in the People’s Republic of China 490371-AA1
For use in South Africa 490371-AR1
For use in Switzerland 490371-111
For use in Taiwan 490371-AB1
For use in Thailand 490371-201
For use in the United Kingdom 490371-031
For use in the United States 490371-001
Power cords, 1.0 m, 3-pin:

For use in Argentina 755530-D01
For use in Australia 755530-011
For use in Denmark 755530-081
For use in Europe, the Middle East, and Africa 755530-021
For use in India 755530-D61
For use in Israel 755530-BB1
For use in Italy 755530-061
For use in Japan 755530-291
For use in the People’s Republic of China 755530-AA1
For use in South Africa 755530-AR1
For use in Switzerland 755530-111
For use in Taiwan 755530-AB1
For use in Thailand 755530-201
For use in the United Kingdom 755530-031
For use in the United States 755530-001
Power cords, 1.0 m, 2-pin:

For use in Japan 762689-291

Power cords, 1.8 m, 2-pin:
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Description Spare part number

For use in Japan 753361-001
Mouse

USB, laser 674318-001
USB, optical, travel 434594-001
Case

Top load 679921-001
Messenger 679922-001
Backpack 679923-001
Expansion base, USB 3.0 port replicator 690650-001
Rubber Kit (includes rubber base enclosure screw covers and mylar display bezel screw covers) 768136-001
Screw Kit 768137-001
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4 Removal and replacement procedures
preliminary requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:
e  Flat-bladed screwdriver
e  Phillips PO and P1 screwdrivers

° Torx T8 screwdriver

Service considerations

The following sections include some of the considerations that you must keep in mind during disassembly
and assembly procedures.

99

& NOTE: As you remove each subassembly from the computer, place the subassembly (and all accompanying
screws) away from the work area to prevent damage.

Plastic parts

A CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use care
when handling the plastic parts. Apply pressure only at the points designated in the maintenance
instructions.
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Cables and connectors

A CAUTION: When servicing the computer, be sure that cables are placed in their proper locations during the
reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat or seat
the cables during removal and insertion. Handle cables by the connector whenever possible. In all cases, avoid
bending, twisting, or tearing cables. Be sure that cables are routed in such a way that they cannot be caught
or snagged by parts being removed or replaced. Handle flex cables with extreme care; these cables

tear easily.

Drive handling

A CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the computer is
off or in Hibernation, turn the computer on, and then shut it down through the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive, avoid
touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and be sure
that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure determine
the degree of sensitivity. Networks built into many integrated circuits provide some protection, but in many
cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a normal
cycle. Or the device may function normally for a while, and then degrade in the internal layers, reducing its life
expectancy.

A CAUTION: To prevent damage to the computer when you are removing or installing internal components,
observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.
Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described in this
section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

A CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000V 15,000V 7,500V
Walking across vinyl floor 12,000V 5,000V 3,000V
Motions of bench worker 6,000V 800V 400V
Removing DIPS from plastic tube 2,000V 700V 400V
Removing DIPS from vinyl tray 11,500V 4,000V 2,000V
Removing DIPS from Styrofoam 14,500V 5,000V 3,500V
Removing bubble pack from PCB 26,500V 20,000V 7,000V
Packing PCBs in foam-lined box 21,000V 11,000V 5,000V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.
Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

Place items on a grounded surface before removing items from their containers.

Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized
equipment used for moving materials is wired to ground and that proper materials are selected to avoid
static charging. When grounding is not possible, use an ionizer to dissipate electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools and
equipment.

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these
items only at static-free workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.

Service considerations
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

e  When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps with a
minimum of one megohm +10% resistance in the ground cords. To provide proper ground, wear a strap
snugly against the skin at all times. On grounded mats with banana-plug connectors, use alligator clips
to connect a wrist strap.

e  When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can be
used at standing workstations and are compatible with most types of shoes or boots. On conductive
floors or dissipative floor mats, use foot straps on both feet with a minimum of one megohm resistance
between the operator and ground. To be effective, the conductive strips must be worn in contact with
the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
e  Antistatic tapes

e  Antistatic smocks, aprons, and sleeve protectors

e  (Conductive bins and other assembly or soldering aids

e Nonconductive foam

e  (Conductive tabletop workstations with ground cords of one megohm resistance
e  Static-dissipative tables or floor mats with hard ties to the ground

e  Field service kits

e  Static awareness labels

e  Material-handling packages

e  Nonconductive plastic bags, tubes, or boxes

e  Metal tote boxes

e  Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastic Bags 1,500V
Carbon-loaded plastic Floor mats 7,500V
Metallized laminate Floor mats 5,000V
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5 Removal and replacement procedures for
Customer Self-Repair parts

A CAUTION: The Customer Self-Repair program is not available in all locations. Installing a part not supported
by the Customer Self-Repair program may void your warranty. Check your warranty to determine if Customer
Self-Repair is supported in your location.

[i;’/f’ NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and then
follow the on-screen instructions.

Component replacement procedures

[% NOTE: Please read and follow the procedures described here to access and replace Customer Self-Repair
parts successfully.

[:;’/r NOTE: Details about your computer, including model, serial number, product key, and length of warranty,
are on the service tag at the bottom of your computer. See Labels on page 18 for details.

This chapter provides removal and replacement procedures for Customer Self-Repair parts.

There are as many as 17 screws that must be removed, replaced, or loosened when servicing Customer Self-
Repair parts. Make special note of each screw size and location during removal and replacement.
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Battery

Description Spare part number
4-cell, 44 WHr, 3.0 Ah Li-ion battery 756744-001
4-cell, 40 WHr, 3.0 Ah Li-ion battery 756746-001

Before removing the battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

To remove the battery:

A CAUTION: Removing a battery that is the sole power source for the computer can cause loss of information.
To prevent loss of information, save your work and shut down the computer through Windows before
removing the battery.

1. Turn the computer upside down on a flat surface.
2. Slide the battery lock latch (1), and then slide the battery release latch (2) to release the battery.

3.  Tilt the battery upward (3) and remove it from the computer (4).
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Service door

Description Spare part number

Service doors (includes large and small service door) 768134-001

Before removing the service door, follow these steps:

1.

4.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

To remove the service door:

1.

2.

With the battery bay away from you, loosen the service door screw (1). The service door screw secures
both service doors.

Slide the larger service door away from the battery bay (2) to remove it.

[% NOTE: The larger service door provides access to the hard drive and memory modules.

Component replacement procedures

37



3. Slide the smaller service door away from the battery bay (3) to release it, and then lift the service door
(4) to remove it.

gkk)

= NOTE: The smaller service door provides access to the wireless modules, optical drive security screw,
and keyboard screws. You must remove the large service door to remove the small service door.
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Hard drive

Description Spare part number
Hard drives

1.5-TB, 5400-rpm, 9.5 mm 747375-001
750-GB, 7200-rpm (HP 450 model only) 778191-001
750-GB, 5400-rpm 778190-001
500-GB, 7200-rpm 778189-001
500-GB, 5400-rpm 778186-001
500-GB, 5400-rpm, 7 mm, hybrid (8-GB SSD) 732000-001
320-GB, 5400-rpm 645088-001

Solid-state drives

256-GB Solid-state drive, TLC, for use in HP 450 models 817630-001
128-GB Solid-state drive, TLC, for use in HP 450 and HP 455 models 822214-001
128-GB Solid-state drive for use in HP 450 models 778175-001
128-GB Solid-state drive for use in HP 455 models 773069-001
120-GB Solid-state drive, M.2, for use in HP 450 models 768469-001

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the large service door (see Service door on page 37).

To remove a hard drive:
1.  Remove the 4 Phillips PM2.5x3.0 screws (1) that secure the hard drive to the chassis.

2. Slide the hard drive (2) away from the center of the computer to disengage it from the connector.
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3.  Pullthe plastic tab (3) to remove the hard drive from the bay.

4. Toremove the hard drive cover and bracket from the hard drive, lift the Mylar cover up off the drive (1),
remove the 4 Phillips PM3.0=3.0 screws (2) that secure the bracket to the drive, and then lift the bracket
up and off the hard drive (3).

Reverse this procedure to install a hard drive.
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Memory modules

Ej?)y NOTE: Primary and expansion memory is installed in a stacked configuration in the bottom of the computer.

If only one memory module is installed, it must be installed in the bottom socket.

Description Spare part number
2-GB (PC3L-12800, 1600-MHz, DDR3L) 691739-001
4-GB (PC3L-12800, 1600-MHz, DDR3L) 691740-001
8-GB (PC3L-12800, 1600-MHz, DDR3L) 693374-001

Update BIOS before adding memory modules

Before adding new memory, make sure you update the computer to the latest BIOS.

A CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may result in
various system problems.

To update BIOS:

1.

2
3
4
5.
6
7
8

Navigate to www.hp.com.

Click Support & Drivers > click Drivers & Software.

In the Enter a product name/number box, type the computer model information, and then click Search.
Click the link for the computer model.

Select the operating system, and then click Next.

Under Step 2: Select a Download, click the BIOS link.

Click the link for the most recent BIOS.

Click the Download button, and then follow the on-screen instructions.

Before removing the memory module, follow these steps:

1.

4.
5,

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove the large service door (see Service door on page 37).

Remove the memory module:

1.

Spread the retaining tabs (1) on each side of the memory module slot to release the memory module.
(The edge of the module opposite the slot rises away from the computer.)
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2. Remove the memory module (2) by pulling the module away from the slot at an angle.

gkk)

&’ NOTE: Memory modules are designed with a notch to prevent incorrect insertion into the memory
module slot.

[Zq’/f NOTE: The computer uses two memory sockets. The top socket houses the expansion memory
module and the bottom socket houses the primary memory module. The removal procedure is the same
for both memory sockets.

Reverse this procedure to install a memory module.
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Optical drive

Ej?)y NOTE: All optical drive spare part kits include an optical drive bezel, bracket, and screws.

Description Spare part number

For use in HP 450 models:

DVD-ROM drive 768470-001
Blu-ray ROM DVD+RW SuperMulti DL Drive 768472-001
DVD+RW SuperMulti DL Drive 768471-001

For use in HP 455 models:

DVD-ROM drive 773070-001

DVD+RW SuperMulti DL Drive 773071-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove both service doors (see Service door on page 37).

Remove the optical drive:
1.  Remove the Phillips PM2.5x6.0 screw (1) that secures the optical drive to the computer.

2.  Push the optical drive tab (2) to release the optical drive from the computer.
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3. Remove the optical drive (3) from the computer.

4. Toremove the bracket from the optical drive, remove the Phillips PM2.0%3.0 screw (1) that secures the
bracket to the drive, and then remove the bracket from the drive (2).

D B

€ ©
°

Reverse this procedure to install an optical drive.
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WLAN/Bluetooth combo card

The computer uses a card that provides both WLAN and Bluetooth functionality.

The WLAN module and WWAN module are not interchangeable.

Description Spare part number
Atheros AR9485 802.11b/g/n 1x1 WiFi Adapter 675794-001
Realtek RTL8188EE 802.11bgn Wi-Fi Adapter 709848-001
Intel Dual Band Wireless-AC 3160 802.11 ac 1x1 WiFi + BT 4.0 combo adapter 710662-001
Broadcom BCM943228HMB 802.11abgn 2x2 Wi-Fi Adapter + Broadcom Bluetooth 4.0 Adapter 730668-001
Broadcom BCM43142 802.11 bgn 1x1 Wi-Fi + BT4.0 HMC combo adapter 753076-001
Realtek RT8723BE 802.11 bgn 1x1 Wi-Fi + BT4.0 combo adapter 753077-001

Intel Dual Band Wireless-AC 7260 802.11 ac 2x2 WiFi + Intel Dual Band Wireless-AC 7260 BT 4.0 combo 756753-001
adapter

Before removing the WLAN module, follow these steps:

1.

4.
5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove both service doors (see Service door on page 37).

Remove the WLAN module:

1.

Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

¥ NOTE: The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal labeled “1”.

The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal labeled “2”. If the
computer is equipped with an 802.11a/b/g/n WLAN module, the yellow WLAN antenna cable connects to
the middle terminal on the WLAN module.

Remove the two Phillips PM2.5x3.0 screws (2) that secure the WLAN module to the computer. (The edge
of the module opposite the slot rises away from the computer.)
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3.  Remove the WLAN module (3) by pulling the module away from the slot at an angle.

[%9 NOTE: WLAN modules are designed with a notch to prevent incorrect insertion.

[%’ NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module, the protective
sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.
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WWAN module

The WLAN module and WWAN module are not interchangeable.

The WWAN module is available on select models only.

Description Spare part number
HP [t4112 LTE/HSPA+ Gobi 4G Module 740011-001
HP hs3110 HSPA+ Mobile Broadband Module 748599-001

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove both service doors (see Service door on page 37).

Remove the WWAN module:
1.  Position the computer upside-down.

2. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

[’_5”? NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The blue
WWAN antenna cable is connected to the WWAN module “Aux” terminal.

3. Remove the two Phillips PM2.5x3.0 screws (2) that secure the WWAN module to the computer. (The
edge of the module opposite the slot rises away from the computer.)
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4. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

[%9 NOTE: WWAN modules are designed with a notch to prevent incorrect insertion.

[% NOTE: If the WWAN antennas are not connected to the terminals on the WWAN module, the protective
sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WWAN module.
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Keyboard

In this section, the first table provides the main spare part number for the keyboards. The second table
provides the country codes.

Description Spare part number
Keyboard, backlit 768130-xxx
Keyboard, no backlight 768787-xxx

For use in country Spare part For use in country Spare part For use in country Spare part
or region number or region number orregion number
Belgium -A41 India -D61 Saudi Arabia -171
Brazil -201 Israel -BB1 Slovenia -BA1
Bulgaria -261 Italy -061 South Korea -AD1
Canada -DB1 Japan -291 Spain -071
Czech Republic -FL1 Latin America -161 Sweden and Finland -B71
and Slovakia

Denmark -081 The Netherlands -B31 Switzerland -BG1
Denmark, Finland, and -DH1 Northern Africa -FP1 Taiwan -AB1
Norway

France -051 Norway -091 Thailand -281
Germany -041 Portugal -131 Turkey -141
Greece -151 Romania =271 United Kingdom -031
Hungary =211 Russia -251 United States -001
Iceland -DD1

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove both service doors (see Service door on page 37).

Remove the keyboard:

1.  Remove the 3 Phillips PM2.5%6.0 screws that secure the keyboard to the computer.
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2. Position the computer upright with the front toward you.
3. Openthe computer as far as possible.

4. Slide the keyboard slightly downward toward the palm rest to disengage the top of the keyboard from
the top cover.
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5. Rotate the top of the keyboard upward (1), and then lift the keyboard up at an angle (2) to disengage the
tabs at the bottom of the keyboard.

2943

= NOTE: A cable connects the bottom of the keyboard to the system board. Make sure not to
prematurely pull the keyboard cable out of the system board connector.

6. Rotate the keyboard until it rests on the palm rest (1).
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7. Disconnect the keyboard cable by lifting the keyboard connector latch (2), and then disconnect the
keyboard cable from the system board (3).

8. Remove the keyboard.

Reverse this procedure to install the keyboard.
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6 Removal and replacement procedures for
Authorized Service Provider parts

A CAUTION: Components described in this chapter should only be accessed by an authorized service provider.
Accessing these parts can damage the computer or void the warranty.

[%’/f NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and then
follow the on-screen instructions.

Component replacement procedures

[% NOTE: Details about your computer, including model, serial number, product key, and length of warranty,
are on the service tag at the bottom of your computer. See Labels on page 18 for details.

This chapter provides removal and replacement procedures for Authorized Service Provider only parts.

There are as many as 60 screws that must be removed, replaced, or loosened when servicing Authorized
Service Provider only parts. Make special note of each screw size and location during removal and
replacement.
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Display subcomponents (bezel, webcam, panel)

This section describes removing display subcomponents that do not require that you remove the entire
display assembly from the computer. You can remove the display bezel, webcam/microphone module, and
display panel while the display assembly is still attached to the computer.

To remove the remaining display subcomponents, you must remove the entire display assembly from the
computer. See Display assembly on page 88 for more information about removing the display assembly in
its entirety.

Before removing display subcomponents while the display assembly is still attached to the computer, follow
these steps:

1.

4,

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then
unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

To remove the display bezel, webcam/microphone module, and raw display panel:

1.
2.

Position the computer upright with the front toward you, and then open it.

To remove the display bezel, remove the 2 mylar screw covers (1) and the 2 Phillips PM2.0x3.0 screws
(2) in the bottom corners of the display bezel.

Flex the top (3) of the bezel, the inside edges of the left and right sides (4), and then the bottom (5) of
the bezel until it disengages from the display enclosure.

[1?? NOTE: Make sure the hinges are not bent (see hinge position in following image) when you remove the

bezel.

If you need to remove the display bezel, remove the 2 mylar screw covers (1) and the 2 Phillips
PM2.0x3.0 screws (2) in the bottom corners of the display bezel.

Flex the top (3) of the bezel, the inside edges of the left and right sides (4), and then the bottom (5) of
the bezel until it disengages from the display enclosure.
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Remove the display bezel (6).

The display bezel is available using spare part number 768125-001 for models with a webcam and
768126-001 for models without a webcam. Display bezel mylar screw covers are available in the Rubber
Kit, spare part number 768136-001.

If it is necessary to replace the webcam or microphone module, gently pull the module away from the
double-sided tape on the display enclosure (1), and then disconnect the cable from the module (2).

The webcam module is available using spare part number 767457-001 for HD models or 807958-001
for Lync models.
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8. Ifitis necessary to remove the display panel from the enclosure, remove the 4 Phillips PM2.0x3.0
screws (1) that secure the panel to the display enclosure, and then lift the top of the panel upward (2).

The raw display panel is available using spare part numbers:
768135-001 for HD, flat panels in HP 450 models
768468-001 for FHD, slim panels on HP 450 models
773072-001 for HD, flat panels on HP 455 models
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9. Rotate the display panel onto the keyboard (1), disconnect the display cable from the rear of the panel
(2), and then remove the display panel (3) from the enclosure.

10. Ifitis necessary to replace the display hinges, remove the 6 Phillips PM2.0x3.0 screws (1) that secure
the display hinges to the display enclosure.

11. Lift the bottom of the hinges upward (2), pull the top of the hinges out from under the tabs (3), and then
remove the display hinges from the display enclosure (4).

Display hinges are available in the Display Hinge Kit using spare part number 768129-001.
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Reverse this procedure to reassemble and install the display bezel, webcam/microphone module, and display
panel.

Top cover

[%'/]’9 NOTE: Top cover spare part kits include the touchpad assembly.

Description Spare part number

Top cover (includes touchpad) 768139-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

4. Remove the following components:

a. Battery (see Battery on page 36).

b. Service doors (see Service door on page 37).

¢. Harddrive (Hard drive on page 39)

d. Optical drive (Optical drive on page 43)

e. Keyboard (see Keyboard on page 49)

Remove the top cover:
1.  Position the computer upside-down with the front toward you.

2. Remove the 6 rubber screw covers and 8 Torx T8M2.5x6.0 screws that secure the top cover to the
computer.
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3. Remove the 11 Torx T8BM2.5x3.0 screws that secure the top cover to the computer.

4. Position the computer upright and open it as far as possible.

5. Disconnect the following cables from the system board:

(1): Card reader board cable
(2): Power button board cable
(3): Function board cable

(4): Speaker cable

(5): USB board cable

6. Remove the 4 Torx TBM2.5x6.0 screws (6) from the top of the computer.

7. Pry the top cover off the computer to disengage it.

@”Y NOTE: Begin by attempting to pry the top cover loose near the optical drive.
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8.  Lift the top of the top cover (1), and the lift the top cover up and remove it from the computer (2).

Reverse this procedure to install the top cover.
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RTC battery, HP 455 models

Description

Spare part number

RTC battery

738824-001

Before removing the RTC battery, follow these steps:

On HP 455 models, you access the RTC battery without removing the system board.

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 36).
5. Remove the following components:
a. Service doors (see Service door on page 37).
b. Hard drive (see Hard drive on page 39)
¢.  Optical drive (see Optical drive on page 43)
d. Keyboard (see Keyboard on page 49)
e. Top cover (see Top cover on page 58)
Remove the RTC battery:
1. Using a flat tool, pry the battery out of the socket (1).
2. Remove the battery from the socket (2).

Reverse this procedure to install the RTC battery.
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Speaker assembly

Description Spare part number

Speaker assembly 768138-001

[%’/]’9 NOTE: You must remove the left speaker to remove to function board cable.

Before removing the speaker assembly, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).
Remove the following components:

a. Service doors (see Service door on page 37).

b. Keyboard (see Keyboard on page 49)

¢. Harddrive (Hard drive on page 39)

d. Optical drive (Optical drive on page 43)

e. Top cover (see Top cover on page 58)

Remove the speaker assembly:

1.
2.
3.

Position the top cover upside-down.
Remove the 2 Phillips PM2.0x3.0 broadhead screws (1) that secure the speakers to the computer.

Slide the speakers toward each other to disengage them from the top cover (2).
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4. Remove the speakers from the top cover (3).

Reverse this procedure to install the speaker assembly.
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Fingerprint reader assembly

Description Spare part number

Fingerprint reader assembly (includes cable, bracket, and bezel) 768128-001

Before removing the fingerprint reader assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the following components:

a. Service doors (see Service door on page 37).

b. Keyboard (see Keyboard on page 49)

¢. Harddrive (Hard drive on page 39)

d. Optical drive (Optical drive on page 43)

e. Top cover (see Top cover on page 58)

Remove the fingerprint reader assembly:
1. Position the top cover upside-down.

2.  Slide the bracket toward the bottom of the top cover (1), and then lift it off the top cover (2).
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3. Remove the fingerprint reader board and cable assembly from the top cover (3).

Reverse this procedure to install the fingerprint reader assembly.

Power button board

Description Spare part number

Power button board assembly 767442-001

Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the following components:

a. Service doors (see Service door on page 37)

b. Keyboard (see Keyboard on page 49)

¢. Harddrive (Hard drive on page 39)
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d. Optical drive (Optical drive on page 43)

e. Top cover (see Top cover on page 58)

Remove the power button board:

1.  Position the top cover upside-down.

2 Remove the Phillips PM2.0x3.0 screw (1) that secures the power button board to the top cover.
3. Slide the board upward to disengage it from the tabs (2).
q

Lift the board up to remove it from the top cover (3), while guiding the cable through the hole in the top
cover (4).

Reverse this procedure to install the power button board.
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Function board

Description

Spare part number

Function board 768131-001

Before removing the function board, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove the following components:

a.
b.
c.
d.

Service doors (see Service door on page 37)

Keyboard (see Keyboard on page 49)

Hard drive (Hard drive on page 39)

Optical drive (Optical drive on page 43)

Top cover (see Top cover on page 58)

Remove the function board:

1.
2.
3.

Position the top cover upside-down.

Remove the Phillips PM2.0x3.0 screw (1) that secures the function board to the top cover.

Slide the board toward the top of the top cover (2), and then lift it off the top cover (3).
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4. Onthe front of the top cover, pull the cable to disengage it from the adhesive that secures it, and then
pull the cable through the hole in the top cover (4).

5. Remove the function board from the top cover.

Reverse this procedure to install the function board.
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Card reader board

Description Spare part number
Card reader board for use in HP 450 models 768133-001
Card reader board for use in HP 455 models 780894-001

Before removing the card reader board, follow these steps:

1.  Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the following components:

a. Service doors (see Service door on page 37).

b. Keyboard (see Keyboard on page 49)

¢. Harddrive (Hard drive on page 39)

d. Optical drive (Optical drive on page 43)

e. Top cover (see Top cover on page 58)

Remove the card reader board:

Ej?)y NOTE: Before you remove the card reader, make sure nothing (memory card or plastic insert) in installed.

1.  Position the top cover upside-down.
2. Disconnect the cable from the board (1).

3. Remove the two Phillips PM2.5%4.0 screws (2) that secure the card reader board to the computer.
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4. Remove the card reader board from the top cover (3).

Reverse this procedure to install the card reader board.
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USB/audio board

Description

Spare part number

USB/audio board 768132-001

Before removing the USB/audio board, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove the following components:

a.
b.
c.
d.

Service doors (see Service door on page 37).

Keyboard (see Keyboard on page 49)

Hard drive (Hard drive on page 39)

Optical drive (Optical drive on page 43)

Top cover (see Top cover on page 58)

Remove the USB/audio board:

1.
2.
3.

Position the top cover upside-down.

Remove the Phillips PM2.5x4.0 screw (1) that secures the USB/audio board to the computer.

Disconnect the cable from the board (2).

Component replacement procedures

71



4. Lift the board off the top cover (3).

Reverse this procedure to install the USB/audio board.
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Touchpad button board

Description Spare part number

Touchpad button board 768140-001

Before removing the touchpad button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the following components:

a. Service doors (see Service door on page 37).

b. Keyboard (see Keyboard on page 49)

¢. Harddrive (Hard drive on page 39)

d. Optical drive (Optical drive on page 43)

e. Top cover (see Top cover on page 58)

Remove the touchpad button board:

1. Position the top cover upside-down.

2. Disconnect the cable from the touchpad (1).

3. Disconnect the cable from the card reader board (2).

4. Remove the Phillips PM2.0x3.0 screw (3) that secures the button board to the top cover.
5

Lift the right side of the touchpad button board up, and then pull it to the right to remove it from the slot
(a).
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6. Lift the touchpad button board off the top cover (5).

Reverse this procedure to install the touchpad button board.
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Fan

Description

Spare part number

Fan

767433-001

E?J”f NOTE: To properly ventilate the computer, allow at least 7.6 cm (3.0 in) of clearance on the left side of the

computer. The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and
is designed to turn on automatically when high temperature conditions exist. These conditions are affected by
high external temperatures, system power consumption, power management/battery conservation

configurations, battery fast charging, and software requirements. Exhaust air is displaced through the
ventilation grill located on the left side of the computer.

Before removing the fan/heat sink assembly, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then

unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36), and then remove the following components:

a.
b.
c
d.

Service doors (see Service door on page 37).

Hard drive (Hard drive on page 39)

Optical drive (Optical drive on page 43)

Keyboard (see Keyboard on page 49)

Top cover (see Top cover on page 58)

To remove the fan:

1.

Disconnect the fan cable (1) from the system board.
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2.  Lift the fan from the computer (2).

Reverse this procedure to install the fan.
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Battery connector cable

The battery connector cable is included in the Cable Kit, spare part number 768127-001.

Before removing the battery connector cable, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove the following components:

a. Service doors (see Service door on page 37).

b. Harddrive (Hard drive on page 39)

c.  Optical drive (Optical drive on page 43)

d. Keyboard (see Keyboard on page 49)

e. Top cover (see Top cover on page 58)

Remove the battery connector cable:

1.

2
3.
q

Disconnect the battery connector cable from the system board (1).
Remove the cable from the clip on the chassis (2).
Remove the 2 Phillips PM2.5x6.0 screws that secure the battery connector cable to the computer (3).

Remove the battery connector cable from the computer (4).

Reverse this procedure to install the battery connector cable.
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System board

78

[%f NOTE: All system board spare part kits include replacement thermal material.

All system boards use the following part numbers:

xXxXxx-001: Windows 7 or non-Windows operating systems

xxxxxx-501: Windows 8.1 Standard operating system

xxxxxx-601: Windows 8.1 or Windows 10 operating system

Description Spare part number
System boards for use in models with Intel processors:

Intel i7-5500U processor; 2-GB discrete graphics memory 799562-XXx
Intel i7-5500U processor; UMA graphics memory; no WWAN models 799553-XXx
Intel i7-5500U processor; UMA graphics memory; WWAN models 799555-XXx
Intel i5-5200U processor; 2-GB discrete graphics memory 799561-xxx
Intel i5-5200U processor; 1-GB discrete graphics memory 799558-xxx
Intel i5-5200U processor; UMA graphics memory; no WWAN models 779552-xxx
Intel i5-5200U processor; UMA graphics memory; WWAN models 799554-xxx
Intel i3-5020U processor; 2-GB discrete graphics memory 824133-xxx
Intel i3-5020U processor; 1-GB discrete graphics memory 824132-xxX
Intel i3-5020U processor; UMA graphics memory; no WWAN models 824129-xxx
Intel i3-5010U processor; 2-GB discrete graphics memory 799560-xxx
Intel i3-5010U processor; 1-GB discrete graphics memory 799557-xXX
Intel i3-5010U processor; UMA graphics memory; no WWAN models 799551-xxx
Intel i3-5005U processor; 2-GB discrete graphics memory 799559-xxx
Intel i3-5005U processor; 1-GB discrete graphics memory 779556-XXx
Intel i3-5005U processor; UMA graphics memory; no WWAN models 799550-xxx
Intel i7-4510U processor; 2-GB discrete graphics memory 768145-xxx
Intel i7-4510U processor; UMA graphics memory; non-WWAN models 768148-xxx
Intel i7-4510U processor; UMA graphics memory, WWAN models 784653-xxx
Intel i5-4210U processor; 2-GB discrete graphics memory 768143-xxx
Intel i5-4210U processor; 1-GB discrete graphics memory 768142-xxx
Intel i5-4210U processor; UMA graphics memory; WWAN models 784652-xxX
Intel i3-4030U processor; 2-GB discrete graphics memory 782950-xxx
Intel i3-4030U processor; UMA graphics memory 782952-xXx
Intel i3-4005U processor; UMA graphics memory 782951-xxx
Intel i5-4210U processor; UMA graphics memory 768146-xxx
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Description Spare part number
Intel Pentium 3825U processor; UMA graphics memory 824130-xxx
Intel Pentium 3805U processor; UMA graphics memory 799549-xxx
Intel Pentium 3558U processor; UMA graphics memory 768150-xxx
Intel Celeron 3215U processor; UMA graphics memory 824128-xxx
Intel Celeron 3205U processor; UMA graphics memory 799548-xxx
System boards for use in models with AMD processors:

AMD FX-7500 processor; 1 GB discrete graphics memory 773080-xxx
AMD A10-7300 processor; 2 GB discrete graphics memory 773079-xxx
AMD A8-7100 processor; 2 GB discrete graphics memory 773078-xxx
AMD A6-7000B processor; 2 GB discrete graphics memory 773077-xxx
AMD A10-7300 processor; UMA graphics memory 773075-xxx
AMD A8-7100 processor; UMA graphics memory 773074-xxx
AMD A6-7050B processor; UMA graphics memory 773073-xxx

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the following components:

a. Service doors (see Service door on page 37).

b. Harddrive (see Hard drive on page 39)

¢.  Optical drive (see Optical drive on page 43)

d. Keyboard (see Keyboard on page 49)

e. Top cover (see Top cover on page 58)

When replacing the system board, be sure to remove the following components from the defective system
board and install on the replacement system board:

e  Memory modules (see Memory modules on page 41)
e  WLAN/Bluetooth module (see WLAN/Bluetooth combo card on page 45)
e  WWAN module (see WWAN module on page 47)

Remove the system board:

1.

Position the computer upright with the front toward you.
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2. Disconnect the following cables from the system board:
(1) Power connector cable
(2) Display cable

(3) Battery connector cable

3. Remove the 3 Phillips PM2.5%4.0 screws (1) that secure the system board and the broadhead Phillips
PM2.0x3.0 screw (2) that secures the optical drive extension board to the computer.

4. Lift the right side of the system board up at an angle (3).
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5.  Pull the system board up and toward the right to remove it from the computer (4).

Reverse this procedure to install the system board.
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Optical drive extension board

You must remove the system board to remove the optical drive extension board.

Before removing the optical drive extension board, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove the following components:

a. Service doors (see Service door on page 37).

b. Harddrive (see Hard drive on page 39)

¢.  Optical drive (see Optical drive on page 43)

d. WLAN module (see WLAN/Bluetooth combo card on page 45)

e. WWAN module (see WWAN module on page 47)

f. Keyboard (see Keyboard on page 49)

g. Top cover (see Top cover on page 58)

h. System board (see System board on page 78)

Remove the optical drive extension board:

1.
2.

Position the system board upright.

Pull the optical drive extension board straight away from the side of the system board.

Reverse this procedure to install the optical drive extension board.
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RTC battery, HP 450 models

Description

Spare part number

RTC battery

738824-001

On HP 450 models, you must remove the system board to access the RTC battery.

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 36).
5. Remove the following components:
a. Service doors (see Service door on page 37).
b. Hard drive (see Hard drive on page 39)
¢. Optical drive (see Optical drive on page 43)
d. Keyboard (see Keyboard on page 49)
e. Top cover (see Top cover on page 58)
f.  System board (see System board on page 78)
Remove the RTC battery:
1.  Position the system board upside-down.
2. Using aflat tool, pry the battery out of the socket (1).
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3. Remove the battery from the socket (2).

Reverse this procedure to install the RTC battery.
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Heat sink assembly

All heat sink assembly spare part kits include replacement thermal material.

Description Spare part number

Heat sink assembly for use in HP 450 (Intel) models:

For use in models with UMA graphics 768048-001
For use in models with discrete graphics and all processors except for the Intel i7-4558U 768050-001
For use in models with discrete graphics and an Intel i7-4558U processor 768049-001

Heat sink assembly for use in HP 455 (AMD) models:

For use in models with UMA graphics 767435-001

For use in models with discrete graphics 767434-001

Before removing the heat sink assembly, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove the following components:

a. Service doors (see Service door on page 37).

b. Hard drive (see Hard drive on page 39)

¢.  Optical drive (see Optical drive on page 43)

d. WLAN module (see WLAN/Bluetooth combo card on page 45)
e. WWAN module (see WWAN module on page 47)

f. Keyboard (see Keyboard on page 49)

g. Top cover (see Top cover on page 58)

h. System board (see System board on page 78)

Remove the heat sink assembly:

1.
2.

Position the system board upside-down.

Models are available with either UMA or discrete graphics. The heat sink on discrete models includes 2
additional screws. Refer to the following steps that match your model:

Discrete models:

a. Toremove the discrete heat sink assembly, in the order indicated on the heat sink, loosen the 6
captive Phillips screws (1) that secure the heat sink to the system board.
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b. Lift the heat sink from the system board (2).

[%”f NOTE: For discrete models, thoroughly clean thermal material from the surfaces of the system
board components (1)(3) and the heat sink (2)(4) each time you remove the heat sink. All heat sink
and processor spare part kits include thermal material.

UMA models:

a. Toremove the UMA heat sink assembly, in the order indicated on the heat sink, loosen the 4
captive Phillips screws (1) that secure the heat sink to the system board.
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b. Lift the heat sink from the system board (2).

)99

B NOTE: For UMA models, thoroughly clean thermal material from the surfaces of the system
board component (1) and the heat sink (2) each time you remove the heat sink. All heat sink and
processor spare part kits include thermal material.

Reverse this procedure to install the heat sink assembly.
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Display assembly

Description Spare part number
Display panel, 39.6-cm (15.6-inch), HD, anti-glare, touch screen, one antenna 782121-001
Display panel, 39.6-cm (15.6-inch), HD, anti-glare, touch screen, two antennas 782122-001

This section describes removing the display assembly in its entirety and disassembling all the display
subcomponents.

The entire display hinge-up is not spared.

If you only need to remove the display bezel, webcam/microphone module, or display panel, you do not need
to remove the entire display assembly from the computer. See Display subcomponents (bezel, webcam,
panel) on page 54 for more information about removing the display subcomponents that do not require that

you remove the entire display assembly from the computer.

Before removing the display assembly, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove the following components:

a. Service doors (see Service door on page 37).

b. Harddrive (see Hard drive on page 39)

¢.  Optical drive (see Optical drive on page 43)

d. WLAN module (see WLAN/Bluetooth combo card on page 45)
e. WWAN module (see WWAN module on page 47)

f. Keyboard (see Keyboard on page 49)

g. Top cover (see Top cover on page 58)

Remove the display assembly:

1.

Position the computer upside down.
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2.

6.

Pull the antenna cables through from the bottom of the computer. Position the computer upside down,
and then remove the cables from the clips near the wireless modules (1), pulling the cables (2) through
the holes (3) in the computer.

Position the computer upright and open.
Disconnect the display cable from the system board (1).

Remove the WLAN antennas and WWAN antennas (if equipped) from the routing path along the base of
the computer (2).

Place the computer upright and open as far as possible.
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7. Remove the 5 Phillips PM2.5x4.0 screws (1) from the display hinges.
8. Lift the display assembly straight up and remove it (2).

A CAUTION: When installing the display assembly, be sure that the wireless antenna cables are routed
and arranged properly.

Failure to properly route the antennas can result in degradation of the computer's wireless performance.

9. If you need to remove the display bezel, remove the 2 mylar screw covers (1) and the 2 Phillips
PM2.0%3.0 screws (2) in the bottom corners of the display bezel.

10. Flex the top (3) of the bezel, the inside edges of the left and right sides (4), and then the bottom (5) of
the bezel until it disengages from the display enclosure.

[%]’> NOTE: Make sure the hinges are not bent (see hinge position in following image) when you remove the
bezel.
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11.

12.

Remove the display bezel (6).

The display bezel is available using spare part number 768125-001 for models with a webcam and
768126-001 for models without a webcam. Display bezel mylar screw covers are available in the Rubber
Kit, spare part number 768136-001.

If it is necessary to replace the webcam or microphone module, gently pull the module away from the
double-sided tape on the display enclosure (1), and then disconnect the cable from the module (2).

The webcam module is available using spare part number 767457-001 for HD models or 807958-001
for Lync models. The microphone module is available using spare part number 773563-001.
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13. Ifitis necessary to remove the display panel from the enclosure, remove the 4 Phillips PM2.0x3.0
screws (1) that secure the panel to the display enclosure, and then lift the top of the panel upward (2).

The raw display panel is available using spare part numbers:
768135-001 for HD, flat panels in HP 450 models
768468-001 for FHD, slim panels on HP 450 models
773072-001 for HD, flat panels on HP 455 models
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14.

15.

16.

Rotate the display panel all the way over (1), disconnect the display cable from the rear of the panel (2),
and then remove the display panel (3) from the enclosure.

If it is necessary to replace the display hinges, remove the 6 Phillips PM2.5x%3.0 screws (1) that secure
the display hinges to the display enclosure.

Lift the bottom of the hinges upward (2), pull the top of the hinges out from under the tabs (3), and then
remove the display hinges from the display enclosure (4).

Display hinges are available in the Display Hinge Kit using spare part number 768129-001.
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17. Ifitis necessary to replace the display/webcam cable, lift the display/webcam cable assembly straight
up and off the display panel.

The display cable is available in the Cable Kit using spare part number 768127-001.

Reverse this procedure to reassemble and install the display assembly.

94 Chapter 6 Removal and replacement procedures for Authorized Service Provider parts



Power connector and cable

Description Spare part number

Power connector and cable 767432-001

Before removing the power cable, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 36).

Remove the following components:

a. Service doors (see Service door on page 37).

b. Keyboard (see Keyboard on page 49)

¢. Harddrive (Hard drive on page 39)

d. Optical drive (Optical drive on page 43)

e. Top cover (see Top cover on page 58)

f.  Display assembly (see Display assembly on page 88)

Remove the power cable:

1.
2.

Disconnect the cable from the bottom of the system board (1).

Remove the cable from the clips built into the computer (2), and then lift the power cable from the
computer (3).

Reverse this procedure to install the power cable.
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7 Computer Setup (BIOS) and MultiBoot in
Windows 7

Using Computer Setup

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup
includes settings for the types of devices installed, the startup sequence of the computer, and the amount of
system and extended memory.

[%’/]’9 NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer from
operating properly.

Starting Computer Setup

[%/r NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB
legacy support is enabled.

To start Computer Setup, follow these steps:

1.  Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

[%”f NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard
to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

e  Toselect a menu or a menu item, use the tab key and the keyboard arrow keys and then press
enter, or use a pointing device to click the item.

e  To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen,
or use the up arrow key or the down arrow key on the keyboard.

e  To close open dialog boxes and return to the main Computer Setup screen, press esc, and then
follow the on-screen instructions.

To exit Computer Setup menus, choose one of the following methods:
e  To exit Computer Setup menus without saving your changes:
Click the Exit icon in the lower-right corner of the screen, and then follow the on-screen instructions.
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Use the arrow keys to select Main > Ignore Changes and Exit, and then press enter.
e  Tosave your changes and exit Computer Setup menus:
Click the Save icon in the lower-right corner of the screen, and then follow the on-screen instructions.
—or-
Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

7 NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press f10 to enter Computer Setup.
Use a pointing device or the arrow keys to select Main > Restore Defaults.

Follow the on-screen instructions.
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To save your changes and exit, click the Save icon in the lower-right corner of the screen, and then
follow the on-screen instructions.

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

[%f NOTE: Your password settings and security settings are not changed when you restore the factory settings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP website.
Most BIOS updates on the HP website are packaged in compressed files called SoftPags.

Some download packages contain a file named Readme.txt, which contains information regarding installing
and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed on the
computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be revealed by pressing fn+esc (if
you are already in Windows) or by using Computer Setup.

1.  Start Computer Setup.
2. Use apointing device or the arrow keys to select Main > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-right corner of the
screen, and then follow the on-screen instructions.
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Use the arrow keys to select Main > Ignore Changes and Exit, and then press enter.

Downloading a BIOS update

A CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and
install a BIOS update only when the computer is connected to reliable external power using the AC adapter. Do
not download or install a BIOS update while the computer is running on battery power, docked in an optional
USB docking device, or connected to an optional power source. During the download and installation, follow
these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1.
2.
3.

Access Help and Support by selecting Start > Help and Support.
Select Updates and tune-ups, and then select Check for HP updates now.
At the download area, follow these steps:

a. ldentify the most recent BIOS update and compare it to the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information to
locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

If the update is more recent than your BIOS, make a note of the path to the location on your hard
drive where the BIOS update is downloaded. You will need to access this path when you are ready
to install the update.

E/f NOTE: If you connect your computer to a network, consult the network administrator before installing

any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are revealed on the screen after the download
is complete. If no instructions are revealed, follow these steps:

1.
2.
3.

5.

Select Start > Computer.
Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

Using the hard drive path you recorded earlier, open the folder on your hard drive that contains the
update.

Double-click the file that has an .exe extension (for example, filename.exe).
The BIOS installation begins.

Complete the installation by following the on-screen instructions.

[%/’”r NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file
from your hard drive.

Using MultiBoot

About the boot device order

As the computer starts, the system attempts to boot from enabled devices. The MultiBoot utility, which is
enabled at the factory, controls the order in which the system selects a boot device. Boot devices can include
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optical drives, diskette drives, a network interface card (NIC), hard drives, and USB devices. Boot devices
contain bootable media or files that the computer needs to start and operate properly.

[%”f NOTE: Some boot devices must be enabled in Computer Setup before they can be included in the boot order.

You can change the order in which the computer searches for a boot device by changing the boot order in
Computer Setup. You can also press esc while the “Press the ESC key for Startup Menu” message is displayed
at the bottom of the screen, and then press f9. Pressing f9 displays a menu that shows the current boot
devices and allows you to select a boot device. Or, you can use MultiBoot Express to set the computer to
prompt you for a boot location each time the computer turns on or restarts.

Choosing MultiBoot preferences

You can use MultiBoot in the following ways:

To set a new boot order that the computer uses each time it is turned on, by changing the boot order in
Computer Setup.

To dynamically choose the boot device, by pressing esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen, and then pressing f9 to enter the Boot Device Options
menu.

To use MultiBoot Express to set variable boot orders. This feature prompts you for a boot device each
time the computer is turned on or restarted.

Setting a new boot order in Computer Setup

To start Computer Setup and set a boot device order that the computer uses each time it is turned on or
restarted, follow these steps:

1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press f10 to enter Computer Setup.
Use a pointing device or the arrow keys to select the Legacy Boot Order list, and then press enter.
To move the device up in the boot order, use a pointing device to click the up arrow, or press the + key.

To move the device down in the boot order, use a pointing device to click the down arrow, or press the -
key.

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the screen,
and then follow the on-screen instructions.

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Dynamically choosing a boot device using the f9 prompt

To dynamically choose a boot device for the current startup sequence, follow these steps:

1.

2.
3.

Open the Select Boot Device menu by turning on or restarting the computer, and then pressing esc while
the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

Press 9.

Use a pointing device or the arrow keys to select a boot device, then press enter.
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Setting a MultiBoot Express prompt

To start Computer Setup and set the computer to display the MultiBoot startup location menu each time the
computer is started or restarted, follow these steps:

1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press f10 to enter Computer Setup.

Use a pointing device or the arrow keys to select System Configuration > Boot Options, and then press
enter.

In the MultiBoot Express Popup Delay (Sec) field, enter the length of time in seconds that you want the
computer to display the startup location menu before it defaults to the current MultiBoot setting. (When
0 is selected, the Express Boot startup location menu is not displayed.)

To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the screen,
and then follow the on-screen instructions.

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Entering MultiBoot Express preferences

When the Express Boot menu is displayed during startup, you have the following choices:

To specify a boot device from the Express Boot menu, select your preference within the allotted time,
and then press enter.

To prevent the computer from defaulting to the current MultiBoot setting, press any key before the
allotted time expires. The computer will not start until you select a boot device and press enter.

To allow the computer to start according to the current MultiBoot settings, wait for the allotted time to
expire.
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8 Computer Setup (BI0S) and MultiBoot in
Windows 8.1

Using Computer Setup

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup
includes settings for the types of devices installed, the startup sequence of the computer, and the amount of
system and extended memory.

Ej?’y NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer from
operating properly.

Starting Computer Setup

[Z?’”r NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB
legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

[’_ﬁ”f NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard
to navigate and make selections in Computer Setup.

2. Press 10 to enter Computer Setup.

e  Toselect a menu or a menu item, use the tab key and the keyboard arrow keys and then press
enter, or use a pointing device to click the item.

e  To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen,
or use the up arrow key or the down arrow key on the keyboard.

e To close open dialog boxes and return to the main Computer Setup screen, press esc, and then
follow the on-screen instructions.

To exit Computer Setup menus, choose one of the following methods:
e  To exit Computer Setup menus without saving your changes:
Click the Exit icon in the lower-right corner of the screen, and then follow the on-screen instructions.
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Use the arrow keys to select Main > Ignore Changes and Exit, and then press enter.
e  Tosave your changes and exit Computer Setup menus:
Click the Save icon in the lower-right corner of the screen, and then follow the on-screen instructions.
—or-
Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

299

B4’ NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1.  Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press f10 to enter Computer Setup.
Use a pointing device or the arrow keys to select Main > Restore Defaults.

Follow the on-screen instructions.
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To save your changes and exit, click the Save icon in the lower-right corner of the screen, and then
follow the on-screen instructions.

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

[%?9 NOTE: Your password settings and security settings are not changed when you restore the factory settings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP website.
Most BIOS updates on the HP website are packaged in compressed files called SoftPags.

Some download packages contain a file named Readme.txt, which contains information regarding installing
and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed on the
computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BI0OS) can be revealed by pressing fn+esc (if
you are already in Windows) or by using Computer Setup.

1.  Start Computer Setup.
2. Use a pointing device or the arrow keys to select Main > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-right corner of the
screen, and then follow the on-screen instructions.
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Use the arrow keys to select Main > Ignore Changes and Exit, and then press enter.

Downloading a BIOS update

A CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and
install a BIOS update only when the computer is connected to reliable external power using the AC adapter. Do
not download or install a BIOS update while the computer is running on battery power, docked in an optional
USB docking device, or connected to an optional power source. During the download and installation, follow
these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1.  Fromthe Start screen, type hp support assistant,and thenselect the HP Support Assistant app.
2 Click Updates and tune-ups, and then click Check for HP updates now.

3. Follow the on-screen instructions.

q At the download area, follow these steps:

a. Identify the most recent BIOS update and compare it to the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information to
locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

If the update is more recent than your BIOS, make a note of the path to the location on your hard
drive where the BIOS update is downloaded. You will need to access this path when you are ready
to install the update.

E/? NOTE: If you connect your computer to a network, consult the network administrator before installing
any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are revealed on the screen after the download
is complete. If no instructions are revealed, follow these steps:

1. From the Start screen, type £1i1le, and then select File Explorer.
2. Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains the
update.

4. Double-click the file that has an .exe extension (for example, filename.exe).
The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

Ej% NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file
from your hard drive.
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Using MultiBoot

About the boot device order

As the computer starts, the system attempts to boot from enabled devices. The MultiBoot utility, which is
enabled at the factory, controls the order in which the system selects a boot device. Boot devices can include
optical drives, diskette drives, a network interface card (NIC), hard drives, and USB devices. Boot devices
contain bootable media or files that the computer needs to start and operate properly.

[%?9 NOTE: Some boot devices must be enabled in Computer Setup before they can be included in the boot order.

You can change the order in which the computer searches for a boot device by changing the boot order in
Computer Setup. You can also press esc while the “Press the ESC key for Startup Menu” message is displayed
at the bottom of the screen, and then press f9. Pressing f9 displays a menu that shows the current boot
devices and allows you to select a boot device. Or, you can use MultiBoot Express to set the computer to
prompt you for a boot location each time the computer turns on or restarts.

Choosing MultiBoot preferences
You can use MultiBoot in the following ways:

e Tosetanew boot order that the computer uses each time it is turned on, by changing the boot order in
Computer Setup.

e  Todynamically choose the boot device, by pressing esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen, and then pressing f9 to enter the Boot Device Options
menu.

e  Touse MultiBoot Express to set variable boot orders. This feature prompts you for a boot device each
time the computer is turned on or restarted.

Setting a new boot order in Computer Setup

To start Computer Setup and set a boot device order that the computer uses each time it is turned on or
restarted, follow these steps:

1.  Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.
3. Useapointing device or the arrow keys to select one of the following options:
e  Advanced > Boot Options > UEFI Boot Order > UEFI Hybrid
e  Advanced > Boot Options > UEFI Boot Order > UEFI Native Boot mode
e  Advanced > Boot Options > Legacy Boot Order > Legacy Boot Mode
Press enter.
4. To move the device up in the boot order, use a pointing device to click the up arrow, or press the + key.
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To move the device down in the boot order, use a pointing device to click the down arrow, or press the -
key.

5. Tosave your changes and exit Computer Setup, click the Save icon in the lower-left corner of the screen,
and then follow the on-screen instructions.

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Dynamically choosing a boot device using the f9 prompt
To dynamically choose a boot device for the current startup sequence, follow these steps:

1.  Open the Select Boot Device menu by turning on or restarting the computer, and then pressing esc while
the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2. Pressf9.

3. Useapointing device or the arrow keys to select a boot device, then press enter.

Setting a MultiBoot Express prompt

To start Computer Setup and set the computer to display the MultiBoot startup location menu each time the
computer is started or restarted, follow these steps:

1. Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Useapointing device or the arrow keys to select Advanced > Boot Options > MultiBoot Express Boot
Popup Delay (Sec), and then press enter.

4. Inthe MultiBoot Express Popup Delay (Sec) field, enter the length of time in seconds that you want the
computer to display the startup location menu before it defaults to the current MultiBoot setting. (When
0 is selected, the Express Boot startup location menu is not displayed.)

5. Tosave your changes and exit Computer Setup, click the Save icon in the lower-left corner of the screen,
and then follow the on-screen instructions.

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Entering MultiBoot Express preferences

When the Express Boot menu is displayed during startup, you have the following choices:

e  To specify a boot device from the Express Boot menu, select your preference within the allotted time,
and then press enter.

e  To prevent the computer from defaulting to the current MultiBoot setting, press any key before the
allotted time expires. The computer will not start until you select a boot device and press enter.

e  Toallow the computer to start according to the current MultiBoot settings, wait for the allotted time to
expire.
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9 Computer Setup (BI0S), TPM, and HP Sure
Start in Windows 10

Using Computer Setup

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup
includes settings for the types of devices installed, the startup sequence of the computer, and the amount of
system and extended memory.

[%f NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer from
operating properly.

Starting Computer Setup

[%/r NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB
legacy support is enabled.

To start Computer Setup, follow these steps:
A Start Computer Setup.
e  Computers or tablets with keyboards:

A Turnon orrestart the computer, and when the HP logo appears, press f10 to enter Computer
Setup.

e  Tablets without keyboards:
A Turn off the tablet. Press the power button in combination with the volume down button until
the Startup menu is displayed, and then tap F10 to enter Computer Setup.

Navigating and selecting in Computer Setup

e  Toselect a menu or a menuitem, use the tab key and the keyboard arrow keys and then press enter, or
use a pointing device to select the item.

A,

B NOTE: On tablets without keyboards, you can use your finger to make selections.

e  Toscroll up and down, select the up arrow or the down arrow in the upper-right corner of the screen, or
use the up arrow key or the down arrow key on the keyboard.

e To close open dialog boxes and return to the main Computer Setup screen, press esc, and then follow
the on-screen instructions.
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To exit Computer Setup menus, choose one of the following methods:

e  To exit Computer Setup menus without saving your changes:
Select the Exit icon in the lower-right corner of the screen, and then follow the on-screen instructions.
—or-
Select Main, select Ignore Changes and Exit, and then press enter.

e  To save your changes and exit Computer Setup menus:
Select the Save icon in the lower-right corner of the screen, and then follow the on-screen instructions.
—or-
Select Main, select Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

[ NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1.  Start Computer Setup. See Starting Computer Setup on page 106.

2. Select Main, and then select Apply Factory Defaults and Exit.

EX NOTE: On select products, the selections may display Restore Defaults instead of Apply Factory
Defaults and Exit.

3. Follow the on-screen instructions.

4. To save your changes and exit, select the Save icon in the lower-right corner of the screen, and then
follow the on-screen instructions.

Select Main, select Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

[%r NOTE: Your password settings and security settings are not changed when you restore the factory settings.
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Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPags.

Some download packages contain a file named Readme.txt, which contains information regarding installing
and troubleshooting the file.

Determining the BIOS version

To decide whether you need to update Computer Setup (BIOS), first determine the BIOS version on your
computer.

BIOS version information (also known as ROM date and System BIOS) can be accessed by pressing fn+esc (if
you are already in Windows) or by using Computer Setup.

1.  Start Computer Setup. See Starting Computer Setup on page 106.

2. Select Main, and then select System Information.

3. To exit Computer Setup without saving your changes, select the Exit icon in the lower-right corner of the
screen, and then follow the on-screen instructions.

Select Main, select Ignore Changes and Exit, and then press enter.

To check for later BIOS versions, see Downloading a BIOS update on page 108.

Downloading a BIOS update

A CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and
install a BIOS update only when the computer is connected to reliable external power using the AC adapter. Do
not download or install a BIOS update while the computer is running on battery power, docked in an optional
docking device, or connected to an optional power source. During the download and installation, follow these
instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Type support in the taskbar search box, and then select the HP Support Assistant app.
—or-
Select the question mark icon in the taskbar.

2. Select Updates, and then select Check for updates and messages.

3. Follow the on-screen instructions.

4. Atthe download area, follow these steps:

a. ldentify the most recent BIOS update and compare it to the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information to
locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is downloaded.
You will need to access this path when you are ready to install the update.
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[%f NOTE: If you connect your computer to a network, consult the network administrator before installing
any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are revealed on the screen after the download
is complete. If no instructions are revealed, follow these steps:

1. Type fileinthe taskbar search box, and then select File Explorer.
2. Select your hard drive designation. The hard drive designation is typically Local Disk (C:).
3. Using the hard drive path you recorded earlier, open the folder that contains the update.
4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

[%”f NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file
from your hard drive.

Changing the boot order using the f9 prompt
To dynamically choose a boot device for the current startup sequence, follow these steps:
1. Access the Boot Device Options menu:
e  Computers or tablets with keyboards:

A Turnon or restart the computer, and when the HP logo appears, press f9 to enter the Boot
Device Options menu.

e  Tablets without keyboards:

A Turn off the tablet. Press the power button in combination with the volume down button until
the Startup menu is displayed, and then tap F9 to enter the Boot Device Options menu.

2. Select aboot device, then press enter.

TPM BIOS settings (select products only)

M" IMPORTANT: Before enabling Trusted Platform Module (TPM) functionality on this system, you must ensure
that your intended use of TPM complies with relevant local laws, regulations and policies, and approvals or
licenses must be obtained if applicable. For any compliance issues arising from your operation/usage of TPM
which violates the above mentioned requirement, you shall bear all the liabilities wholly and solely. HP will
not be responsible for any related liabilities.

TPM provides additional security for your computer. You can modify the TPM settings in Computer Setup
(BIOS).

Ej?)y NOTE: If you change the TPM setting to Hidden, TPM is not visible in the operating system.

To access TPM settings in Computer Setup:

1. Start Computer Setup. See Starting Computer Setup on page 106.

2. Select Security, select TPM Embedded Security, and then follow the on-screen instructions.
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Using HP Sure Start (select products only)

Select computer models are configured with HP Sure Start, a technology that continuously monitors the
computer's BIOS for attacks or corruption. If the BIOS becomes corrupted or is attacked, HP Sure Start
automatically restores the BIOS to its previously safe state, without user intervention.

HP Sure Start is configured and already enabled so that most users can use the HP Sure Start default
configuration. The default configuration can be customized by advanced users.

To access the latest documentation on HP Sure Start, go to http://www.hp.com/support, and select your
country. Select Drivers & Downloads, and then follow the on-screen instructions.
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10 Computer Setup (BI0S) in Ubuntu Linux

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup
includes settings for the types of peripherals installed, the startup sequence of the computer, and the
amount of system and extended memory.

[%”r NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer from
operating properly.

Starting Computer Setup

[% NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB
legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

e  Toselect a menu or a menu item, use the tab key and the keyboard arrow keys and then press
enter, or use a pointing device to click the item.

e  Toscroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen,
or use the up arrow key or the down arrow key.

e  To close open dialog boxes and return to the main Computer Setup screen, press esc, and then
follow the on-screen instructions.

r_ﬁ”f NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard
to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.
To exit Computer Setup menus, choose one of the following methods:

e  To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

Use the arrow keys to select Main > Ignore Changes and Exit, and then press enter.
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e  Tosave your changes and exit Computer Setup menus, click the Save icon in the lower-left corner of the
screen, and then follow the on-screen instructions.

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

299

E’ NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1.  Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press f10 to enter Computer Setup.
Use a pointing device or the arrow keys to select Main > Restore Defaults.

Follow the on-screen instructions.

i & w N

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then follow
the on-screen instructions.

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

[%r NOTE: Your password settings and security settings are not changed when you restore the factory settings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.
Most BIOS updates on the HP Web site are packaged in compressed files called SoftPags.
Some download packages contain a file named Readme.txt, which contains information regarding installing

and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed on the
computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be revealed as follows:
1.  Start Computer Setup.
2. Use apointing device or the arrow keys to select Main > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of the
screen, and then follow the on-screen instructions.

Use the arrow keys to select Main > Ignore Changes and Exit, and then press enter.
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[%f NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing the esc
key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen, and
then pressing the f1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update

A CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and
install a BIOS update only when the computer is connected to reliable external power using the AC adapter. Do
not download or install a BIOS update while the computer is running on battery power, docked in an optional
docking device, or connected to an optional power source. During the download and installation, follow these
instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1.  Openyour web browser. For U.S. support, go to http://www.hp.com/go/contactHP. For worldwide
support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want to
download.

3. Click the option for software and driver downloads, type your computer model number in the product
box, and then press enter. Follow the on-screen instructions to identify your computer and access the
BIOS update you want to download.

Click your specific product from the models listed.
Click the appropriate operating system.

Go to the BIOS section and download the BIOS software package.

R

Follow the installation instructions as provided with the downloaded BIOS software package.

[:?'”r NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file
from your hard drive.
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11 HP PC Hardware Diagnostics (UEFI)

HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run diagnostic
tests to determine whether the computer hardware is functioning properly. The tool runs outside the
operating system so that it can isolate hardware failures from issues that are caused by the operating system
or other software components.

[%/r NOTE: To start BIOS on a convertible computer, your computer must be in notebook mode and you must use
the keyboard attached to your tablet. The on-screen keyboard, which displays in tablet mode, cannot access
BIOS.

To start HP PC Hardware Diagnostics UEFI:
1.  Start BIOS:
e  Computers or tablets with keyboards:
A Turnon orrestart the computer, quickly press esc.
e  Tablets without keyboards:
A Turnon orrestart the tablet, and then quickly hold down the volume down button.
-or-
Turn on or restart the tablet, and then quickly hold down the Windows button.
2. Pressortap f2.
The BIOS searches three places for the diagnostic tools, in the following order:

a. Connected USB drive

[% NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see Downloading
HP PC Hardware Diagnostics (UEFI) to a USB device on page 114.

b. Harddrive
c. BIOS

3. When the diagnostic tool opens, select the type of diagnostic test you want to run, and then follow the
on-screen instructions. On a tablet, press the volume down button to stop a diagnostic test.

[%/r NOTE: If you need to stop a diagnostic test on computers or tablets with a keyboard, press esc.

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device

There are two options to download HP PC Hardware Diagnostics to a USB device:
Download the latest UEFI version:

1.  Goto http://www.hp.com/go/techcenter/pcdiags. The HP PC Diagnostics home page is displayed.

2. Inthe HP PC Hardware Diagnostics section, click the Download link, and then select Run.
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Download any version of UEFI for a specific product:

1.
2.
3.

Go to http://www.hp.com/support, and then select your country. The HP Support page is displayed.

Click Drivers & Downloads.

In the text box, enter the product name, and then click Go.
—or—

Click Find Now to let HP automatically detect your product.
Select your computer, and then select your operating system.

In the Diagnostic section, follow the on-screen instructions to select and download the UEFI version
you want.
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12 Backup and recovery in Windows 7

Your computer includes HP and Windows tools to help you safeguard your information and retrieve it if you
ever need to. These tools will help you return your computer to a proper working state, all with simple steps.
This section provides information about the following processes:

e  C(reating recovery media and backups

e  Restoring and recovering your system

Creating recovery media and backups

Recovery after a system failure is only as good as your most recent backup.

1.  After you successfully set up the computer, create HP Recovery media. This step creates a Windows 7
operating system DVD and a Driver Recovery DVD. The Windows DVD can be used to reinstall the original
operating system in cases where the hard drive is corrupted or has been replaced. The Driver Recovery
DVD installs specific drivers and applications. See Creating recovery media with HP Recovery Disc
Creator on page 116.

2. Use Windows Backup and Recovery tools to perform the following:
e  Back upindividual files and folders
e  Back up your entire hard drive (select models only)

e  (reate system repair discs (select models only) with the installed optical drive (select models only)
or an optional external optical drive

e  (reate system restore points

[%’/]’9 NOTE: This guide describes an overview of backing up, restoring, and recovering options. For more details
about the tools provided, see Help and Support. To access Help and Support, select Start > Help and Support.

[%,’/r NOTE: HP recommends that you print the recovery procedures and save them for later use, in case of
system instability.

In case of system failure, you can use the backup files to restore the contents of your computer. See Backing
up your information on page 117.

Guidelines

e  When creating recovery media or backing up to discs, use any of the following types of discs (purchased
separately): DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend on the type
of optical drive you are using.

e  Besure that the computer is connected to AC power before you start the recovery media creation
process or the backup process.

Creating recovery media with HP Recovery Disc Creator

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery media. After
you successfully set up the computer, you can create recovery media using HP Recovery Disc Creator. This
recovery media allows you to reinstall your original operating system as well as select drivers and
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applications if the hard drive becomes corrupted. HP Recovery Disc Creator can create two kinds of recovery
DVDs:

e  Windows 7 operating system DVD—Installs the operating system without additional drivers or
applications.

e  Driver Recovery DVD—Installs specific drivers and applications only, in the same way that the HP
Software Setup utility installs drivers and applications.

Creating recovery media

E/f NOTE: The Windows 7 operating system DVD can be created only once. Thereafter, the option to create that
media will not be available after you create a Windows DVD.

To create the Windows DVD:

1.  Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Windows disk.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Create button to start the burning process.

After the Windows 7 operating system DVD has been created, create the Driver Recovery DVD:
1.  Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Driver disk.

3. From the drop-down menu, select the drive for burning the recovery media.

4

Click the Create button to start the burning process.

Backing up your information

You should create system repair media and your initial backup immediately after initial system setup. As you
add new software and data files, you should continue to back up your system on a regular basis to maintain a
reasonably current backup. You should also create Windows system repair media (select models only) which
can be used to start up (boot) the computer and repair the operating system in case of system instability or
failure. Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:

e  Store personal files in the Documents library, and back it up regularly.

e  Back up templates that are stored in their associated directories.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your
settings. The screen shot can be a time-saver if you have to reset your preferences.

e  When backing up to discs, number each disc after removing it from the drive.

E/f NOTE: For detailed instructions on various backup and restore options, perform a search for these topics in
Help and Support. To access Help and Support, select Start > Help and Support.

E/{ NOTE: Windows includes the User Account Control feature to improve the security of your computer. You
may be prompted for your permission or password for tasks such as installing software, running utilities, or
changing Windows settings. Refer to Help and Support. To access Help and Support, select Start > Help and
Support.
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To create a backup using Windows Backup and Restore:

[%/'”r NOTE: The backup process may take over an hour, depending on file size and the speed of the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models only), or
create system repair media (select models only).

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

e  Windows recovery tools: You can use Windows Backup and Restore to recover information you have
previously backed up. You can also use Windows Startup Repair to fix problems that might prevent
Windows from starting correctly.

e {11 recovery tools (select models only): You can use the f11 recovery tools to recover your original hard
drive image. The image includes the Windows operating system and software programs installed at the
factory.

[%/’”r NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair media you
previously created (select models only), you must purchase Windows 7 operating system media to reboot the
computer and repair the operating system. For additional information, see Using Windows 7 operating system
media on page 119.

Using the Windows recovery tools
Using the Windows recovery tools, you can:
e  Recover individual files
e  Restore the computer to a previous system restore point

° Recover information using recovery tools

[%r NOTE: For detailed instructions on various recovery and restore options, perform a search for these topics
in Help and Support. To access Help and Support, select Start > Help and Support.

[%)/r’ NOTE: Windows includes the User Account Control feature to improve the security of your computer. You
may be prompted for your permission or password for tasks such as installing software, running utilities, or
changing Windows settings. Refer to Help and Support. To access Help and Support, select Start > Help and
Support.

To recover information you previously backed up:
1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models only),
or your files.

To recover your information using Startup Repair, follow these steps:

A CAUTION: Some Startup Repair options will completely erase and reformat the hard drive. All files you have
created and any software installed on the computer are permanently removed. When reformatting is
complete, the recovery process restores the operating system, as well as the drivers, software, and utilities
from the backup used for recovery.

118 Chapter 12 Backup and recovery in Windows 7



1. If possible, back up all personal files.
2. If possible, check for the presence of the Windows partition.

To check for the Windows partition, select Start > Computer.

[%”r NOTE: If the Windows partition is not listed, you must recover your operating system and programs
using the Windows 7 operating system DVD and the Driver Recovery media. For additional information,
see Using Windows 7 operating system media on page 119.

3. If the Windows partition is listed, restart the computer, and then press 8 before the Windows operating
system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

Ej?)y NOTE: For additional information on recovering information using the Windows tools, select Start > Help
and Support.

Using f11 recovery tools (select models only)

A CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files that you
have created and any software that you have installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the factory.
Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:
1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: click Start, right-click Computer, click
Manage, and then click Disk Management.

[’_5”? NOTE: If the HP Recovery partition is not listed, you must recover your operating system and programs
using the Windows 7 operating system media and the Driver Recovery media. For additional information,
see Using Windows 7 operating system media on page 119.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the ESC
key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using Windows 7 operating system media

If you cannot use the recovery media you previously created using the HP Recovery Disc Creator (select
models only), you must purchase a Windows 7 operating system DVD to reboot the computer and repair the
operating system.

To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to
http://www.hp.com/support. For worldwide support, go to http://welcome.hp.com/country/us/en/
wwcontact_us.html. You can also order the DVD by calling support. For contact information, see the
Worldwide Telephone Numbers booklet included with the computer.

A CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and reformats
the hard drive. All files that you have created and any software that you have installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the operating
system, as well as drivers, software, and utilities.
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To initiate recovery using a Windows 7 operating system DVD:

[%/'”r NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive before
the Windows operating system loads.

When prompted, press any keyboard key.
Follow the on-screen instructions.
Click Next.

Select Repair your computer.

A S

Follow the on-screen instructions.
After the repair is completed:
1.  Eject the Windows 7 operating system DVD and then insert the Driver Recovery DVD.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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13 Backup and recovery in Windows 8.1

To protect your information, use Windows backup and restore utilities to back up individual files and folders,
back up your entire hard drive, create system repair media (select models only) by using the installed optical
drive (select models only) or an optional external optical drive, or create system restore points. In case of
system failure, you can use the backup files to restore the contents of your computer.

From the Start screen, type restore, click Settings, and then select from the list of displayed options.

E?’”f} NOTE: For detailed instructions on various backup and restore options, perform a search for these topics in
Windows Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for later
use.

[Z;’/f’ NOTE: Windows includes the User Account Control feature to improve the security of your computer. You
may be prompted for your permission or password for tasks such as installing software, running utilities, or
changing Windows settings. For more information, see Windows Help and Support.

Backing up your information

Recovery after a system failure is as good as your most recent backup. You should create system repair media
and your initial backup immediately after initial system setup. As you add new software and data files, you
should continue to back up your system on a regular basis to maintain a reasonably current backup.

For more information on the Windows backup features, see Windows Help and Support.

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

e  Windows recovery tools: You can use Windows Backup and Restore to recover information you have
previously backed up. You can also use Windows Automatic Repair to fix problems that might prevent
Windows from starting correctly.

e {11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image. The
image includes the Windows operating system and software programs installed at the factory.

[%i’ NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair media you
previously created (select models only), you must purchase Windows operating system media to reboot the
computer and repair the operating system. For additional information, see Using Windows operating system
media (purchased separately) on page 123.

Using the Windows recovery tools

To recover information you previously backed up, see Windows Help and Support for steps on restoring files
and folders.

To recover your information using Automatic Repair, follow these steps:
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A CAUTION: Some Startup Repair options will completely erase and reformat the hard drive. All files you have
created and any software installed on the computer are permanently removed. When reformatting is
complete, the recovery process restores the operating system, as well as the drivers, software, and utilities
from the backup used for recovery.

1. If possible, back up all personal files.
2. If possible, check for the presence of the Recovery Image partition and the Windows partition.
From the Start screen, type £i1e, and then click File Explorer.

From the Start screen, type pc, and then select This PC.

[%f NOTE: If the Windows partition and the Recovery Image partition are not listed, you must recover your
operating system and programs using the Windows operating system DVD and the Driver Recovery
media (both purchased separately). For additional information, see Using Windows operating system
media (purchased separately) on page 123.

3. If the Windows partition and the Recovery Image partition are listed, restart the computer by pressing
and holding the shift key while clicking Restart.

4. Select Troubleshoot, then select Advanced Options, and then select Startup Repair.

5. Follow the on-screen instructions.
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= NOTE: For additional information on recovering information using the Windows tools, perform a search for
these topics in Windows Help and Support.

Using f11 recovery tools

/\ CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files that you
have created and any software that you have installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the factory.
Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:
1. If possible, back up all personal files.

2. If possible, check for the presence of the Recovery Image partition: From the Start screen, type pc, and
then select This PC.

[%f NOTE: If the Recovery Image partition is not listed, you must recover your operating system and
programs using the Windows operating system media and the Driver Recovery media (both purchased
separately). For additional information, see Using Windows operating system media (purchased
separately) on page 123.

3. Ifthe Recovery Image partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using Windows operating system media (purchased separately)

To order a Windows operating system DVD, contact support. See the Worldwide Telephone Numbers booklet
included with the computer. You can also find contact information from the HP website. Go to
http://www.hp.com/support, select your country or region, and follow the on-screen instructions.

A CAUTION: Using a Windows operating system media completely erases hard drive contents and reformats
the hard drive. All files that you have created and any software that you have installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the operating
system, as well as drivers, software, and utilities.

To initiate a full install of the operating system using a Windows operating system DVD:

B’ NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Insert the Windows operating system DVD into the optical drive, and then restart the computer.
3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the installation is completed:

1.  Eject the Windows operating system media and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Using Windows Refresh or Windows Reset

When your computer is not working properly and you need to regain system stability, the Windows Refresh
option allows you to start fresh and keep what is important to you.

The Windows Reset option allows you to perform detailed reformatting of your computer, or remove personal
information before you give away or recycle your computer. For more information on these features, see
Windows Help and Support.

Using HP Software Setup

HP Software Setup can be used to reinstall drivers or select software that has been corrupted or deleted from
the system.

1. Fromthe Start screen, type HP Software Setup.
2. Open HP Software Setup.

3. Follow the on-screen directions to reinstall drivers or select software.
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14 Backup and recovery in Windows 10

This chapter provides information about the following processes. The information in the chapter is standard
procedure for most products.

e  C(reating recovery media and backups

e  Restoring and recovering your system

For additional information, refer to the HP support assistant app.

A Type support in the taskbar search box, and then select the HP Support Assistant app.
_or-

Click the question mark icon in the taskbar.

[Q’ IMPORTANT: If you will be performing recovery procedures on a tablet, the tablet battery must be at least
70% charged before you start the recovery process.

IMPORTANT: For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before
beginning any recovery process.

Creating recovery media and backups

The following methods of creating recovery media and backups are available on select products only. Choose
the available method according to your computer model.

e  Use HP Recovery Manager to create HP Recovery media after you successfully set up the computer. This
step creates a backup of the HP Recovery partition on the computer. The backup can be used to reinstall
the original operating system in cases where the hard drive is corrupted or has been replaced. For
information on creating recovery media, see Creating HP Recovery media (select products only)
on page 124. For information on the recovery options that are available using the recovery media, see
Using Windows tools on page 125.

e Use Windows tools to create system restore points and create backups of personal information.

For more information, see Recovering using HP Recovery Manager on page 126.

[% NOTE: If storage is 32 GB or less, Microsoft System Restore is disabled by default.

Creating HP Recovery media (select products only)

If possible, check for the presence of the Recovery partition and the Windows partition. From the Start menu,
select File Explorer, and then select This PC.

e If your computer does not list the Windows partition and the Recovery partition, you can obtain recovery
media for your system from support. See the Worldwide Telephone Numbers booklet included with the
computer. You can also find contact information on the HP website. Go to http://www.hp.com/support,
select your country or region, and follow the on-screen instructions.

124 Chapter 14 Backup and recovery in Windows 10


http://www.hp.com/support

You can use Windows tools to create system restore points and create backups of personal information,
see Using Windows tools on page 125.

e If your computer does list the Recovery partition and the Windows partition, you can use HP Recovery
Manager to create recovery media after you successfully set up the computer. HP Recovery media can be
used to perform system recovery if the hard drive becomes corrupted. System recovery reinstalls the
original operating system and software programs that were installed at the factory and then configures
the settings for the programs. HP Recovery media can also be used to customize the system or restore
the factory image if you replace the hard drive.

° Only one set of recovery media can be created. Handle these recovery tools carefully, and keep
them in a safe place.

° HP Recovery Manager examines the computer and determines the required storage capacity for
the media that will be required.

° To create recovery discs, your computer must have an optical drive with DVD writer capability, and
you must use only high-quality blank DVD-R, DVD+R, DVD-R DL, or DVD+R DL discs. Do not use
rewritable discs such as CD+RW, DVD+RW, double-layer DVD+RW, or BD-RE (rewritable Blu-ray)
discs; they are not compatible with HP Recovery Manager software. Or, instead, you can use a high-
quality blank USB flash drive.

° If your computer does not include an integrated optical drive with DVD writer capability, but you
would like to create DVD recovery media, you can use an external optical drive (purchased
separately) to create recovery discs. If you use an external optical drive, it must be connected
directly to a USB port on the computer; the drive cannot be connected to a USB port on an external
device, such as a USB hub. If you cannot create DVD media yourself, you can obtain recovery discs
for your computer from HP. See the Worldwide Telephone Numbers booklet included with the
computer. You can also find contact information on the HP website. Go to http://www.hp.com/
support, select your country or region, and follow the on-screen instructions.

° Be sure that the computer is connected to AC power before you begin creating the recovery media.
° The creation process can take an hour or more. Do not interrupt the creation process.

° If necessary, you can exit the program before you have finished creating all of the recovery DVDs.
HP Recovery Manager will finish burning the current DVD. The next time you start HP Recovery
Manager, you will be prompted to continue.

To create HP Recovery media:

M IMPORTANT: For atablet with a detachable keyboard, connect the keyboard to the keyboard dock before
beginning these steps.

1. Type recovery inthe taskbar search box, and then select HP Recovery Manager.
2. Select Create recovery media, and then follow the on-screen instructions.

If you ever need to recover the system, see Recovering using HP Recovery Manager on page 126.

Using Windows tools

You can create recovery media, system restore points, and backups of personal information using Windows
tools.

E/f NOTE: |If storageis 32 GB or less, Microsoft System Restore is disabled by default.

For more information and steps, see the Get started app.

A Select the Start button, and then select the Get started app.
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Restore and recovery

There are several options for recovering your system. Choose the method that best matches your situation
and level of expertise:

iZ IMPORTANT: Not all methods are available on all products.

e  Windows offers several options for restoring from backup, refreshing the computer, and resetting the
computer to its original state. For more information see the Get started app.

A Select the Start button, and then select the Get started app.

e If youneed to correct a problem with a preinstalled application or driver, use the Reinstall drivers and/or
applications option (select products only) of HP Recovery Manager to reinstall the individual application
or driver.

A Type recovery in the taskbar search box, select HP Recovery Manager, select Reinstall drivers
and/or applications, and then follow the on-screen instructions.

e If you want to recover the Windows partition to original factory content, you can choose the System
Recovery option from the HP Recovery partition (select products only) or use the HP Recovery media.
For more information, see Recovering using HP Recovery Manager on page 126. If you have not already
created recovery media, see Creating HP Recovery media (select products only) on page 124.

e  Onselect products, if you want to recover the computer's original factory partition and content, or if you
have replaced the hard drive, you can use the Factory Reset option of HP Recovery media. For more
information, see Recovering using HP Recovery Manager on page 126.

e  Onselect products, if you want to remove the recovery partition to reclaim hard drive space, HP
Recovery Manager offers the Remove Recovery Partition option.

For more information, see Removing the HP Recovery partition (select products only) on page 129.

Recovering using HP Recovery Manager

HP Recovery Manager software allows you to recover the computer to its original factory state by using the
HP Recovery media that you either created or that you obtained from HP, or by using the HP Recovery
partition (select products only). If you have not already created recovery media, see Creating HP Recovery
media (select products only) on page 124.

What you need to know before you get started

e  HP Recovery Manager recovers only software that was installed at the factory. For software not provided
with this computer, you must either download the software from the manufacturer's website or reinstall
the software from the media provided by the manufacturer.

M" IMPORTANT: Recovery through HP Recovery Manager should be used as a final attempt to correct
computer issues.

e  HP Recovery media must be used if the computer hard drive fails. If you have not already created
recovery media, see Creating HP Recovery media (select products only) on page 124.

e  Touse the Factory Reset option (select products only), you must use HP Recovery media. If you have not
already created recovery media, see Creating HP Recovery media (select products only) on page 124.

e If your computer does not allow the creation of HP Recovery media or if the HP Recovery media does not
work, you can obtain recovery media for your system from support. See the Worldwide Telephone
Numbers booklet included with the computer. You can also find contact information from the HP

126 Chapter 14 Backup and recovery in Windows 10



website. Go to http://www.hp.com/support, select your country or region, and follow the on-screen
instructions.

M’ IMPORTANT: HP Recovery Manager does not automatically provide backups of your personal data. Before
beginning recovery, back up any personal data you want to retain.

Using HP Recovery media, you can choose from one of the following recovery options:

[%i’ NOTE: Only the options available for your computer display when you start the recovery process.

e  System Recovery—Reinstalls the original operating system, and then configures the settings for the
programs that were installed at the factory.

e  Factory Reset—Restores the computer to its original factory state by deleting all information from the
hard drive and re-creating the partitions. Then it reinstalls the operating system and the software that
was installed at the factory.

The HP Recovery partition (select products only) allows System Recovery only.

Using the HP Recovery partition (select products only)

The HP Recovery partition allows you to perform a system recovery without the need for recovery discs or a
recovery USB flash drive. This type of recovery can be used only if the hard drive is still working.

To start HP Recovery Manager from the HP Recovery partition:

M’ IMPORTANT: For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before
beginning these steps (select products only).

1. Type recovery in the taskbar search box, select Recovery Manager, and then select HP Recovery
Environment.

- or_

For computers or tablets with keyboards attached, press f11 while the computer boots, or press and
hold 11 as you press the power button.

For tablets without keyboards:
Turn on or restart the tablet, and then quickly hold down the volume down button; then select f11.
-or-
Turn on or restart the tablet, and then quickly hold down the Windows button; then select f11.
2. Select Troubleshoot from the boot options menu.

3. Select Recovery Manager, and then follow the on-screen instructions.

Using HP Recovery media to recover

You can use HP Recovery media to recover the original system. This method can be used if your system does
not have an HP Recovery partition or if the hard drive is not working properly.

1. If possible, back up all personal files.

2. Insert the HP Recovery media, and then restart the computer.

[%Y NOTE: If the computer does not automatically restart in HP Recovery Manager, change the computer
boot order. See Changing the computer boot order on page 128.

3. Follow the on-screen instructions.
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Changing the computer boot order

If your computer does not restart in HP Recovery Manager, you can change the computer boot order, which is
the order of devices listed in BIOS where the computer looks for startup information. You can change the
selection to an optical drive or a USB flash drive.

To change the boot order:

[ IMPORTANT: For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before
beginning these steps.

1. Insert the HP Recovery media.
2.  Access BIOS:
For computers or tablets with keyboards attached:
A Turnon orrestart the computer or tablet, quickly press esc, and then press f9 for boot options.
For tablets without keyboards:
A Turnon orrestart the tablet, and then quickly hold down the volume down button; then select £9.
-or-
Turn on or restart the tablet, and then quickly hold down the Windows button; then select 9.
3. Select the optical drive or USB flash drive from which you want to boot.

4. Follow the on-screen instructions.
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Removing the HP Recovery partition (select products only)

HP Recovery Manager software allows you to remove the HP Recovery partition to free up hard drive space.

@f’ IMPORTANT: After you remove the HP Recovery partition, you will not be able to perform System Recovery
or create HP recovery media from the HP Recovery partition. So before you remove the Recovery partition,
create HP Recovery media; see Creating HP Recovery media (select products only) on page 124.

[:?’”r NOTE: The Remove Recovery Partition option is only available on products that support this function.

Follow these steps to remove the HP Recovery partition:
1. Type recovery inthe taskbar search box, and then select HP Recovery Manager.

2. Select Remove Recovery Partition, and then follow the on-screen instructions.
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15 Backup and Recovery in Ubuntu Linux

Recovery after a system failure is as good as your most recent backup. As you add new software and data
files, you should continue to back up your system on a regular basis to maintain a reasonably current backup.

Your computer includes tools provided by HP to help you safeguard your information and retrieve it if ever
needed.

Creating backups

1.  Create restore media immediately after you set up the computer. For more information, see Performing
a system recovery on page 131.

2. Asyou add files, routinely create a backup of your system and personal information.

Backing up your information

You should back up your computer files on a regular schedule to maintain a current backup. You can manually
back up your information to an optional external drive, a network drive, or discs. Back up your system at the
following times:

e  Atregularly scheduled times

e  Before the computer is repaired or restored

e  Before you add or modify hardware or software

To back up your home directory files using Backup Manager Settings:

1.  Select Computer > More Applications > Tools > Backup Manager Settings, and click Backup my home
directory.

2. Click Storage Destination Location, and then select a location to back up your information.
3. Click Schedule, and then select a time schedule to perform backups at a regularly scheduled time.

To immediately back up your information, click the Backup Now check box.

A,

= NOTE: Before you back up your information, be sure you have designated a location to save the
backup files.

4. C(Click Save and Backup to start the backup and to save the backup settings.
To restore backup files:

1. Select Computer > More Applications > Tools > Backup Manager Restore.

2. Click Backup Source, and then select the location of the backup files.

3. Click Restore Destination, and then select the destination to restore the files.
q

To restore all files from the selected location, click Restore all files. To restore select files only, click
Restore selected files, click Select Files and then select the files to be restored.

5. Under Restore Point, click the time and date of the backup.
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[%f NOTE: If multiple backups have been performed, click Use the latest version to restore the latest
version.

6. Click Restore to start restoring the files, or click Cancel to cancel the operation.

Performing a system recovery

Recovery allows you to repair or restore the computer to its original factory state. You can create an HP
Factory Image, using an installed or an external DVD+RW optical drive.

[%f NOTE: Your computer may not come equipped with an internal optical drive. In order to create the HP
Factory Image, you may need to plug in an external optical drive.

A CAUTION: Using Recovery completely erases hard drive contents and reformats the hard drive. All files you
have created and any software installed on the computer are permanently removed. The recovery tool
reinstalls the original operating system and HP programs and drivers that were installed at the factory.
Software, drivers, and updates not installed by HP must be manually reinstalled. Personal files must be
restored from a backup.

To restore the computer using the HP Factory Image, you must first create the recovery ISO file and then burn
it to an optical disc.

[%”f NOTE: HP recommends that you create the HP Factory Image in the event of a system failure.

1. Select Computer > More Applications.

2. Inthe left pane, click Tools, and then click Create HP Factory Image in the right pane.

3. Enter the root password when prompted.

4. Right-click on the HP_Recovery.iso file and select Open with Brasero.

5. Insert a blank DVD disc and select Burn. This creates the HP Factory Image Restore DVD.

To restore the computer from the recovery disc, follow these steps:

1. If possible, back up all personal files.
Insert the HP Factory Image Restore DVD into the optical drive and restart the computer.
As the computer is restarting, press f9 to open the Computer Setup boot option menu.

2
3
4. Select Optical Disk Drive from the Boot Options menu and press enter.
5. Press enter to select Restore System from Media.

6

At both of the System Recovery prompts, select Yes.

USB Recovery option (select models only)

The USB Recovery Disk On Key (flash drive) option allows you to create a backup image of the Ubuntu
operating system installed on select HP Business Notebooks. This Disk On Key may be used to restore the
system to the original factory state when the F11 recovery option is not available. This process should be
done on first obtaining the computer.

A CAUTION: The USB recovery option does not preserve data present on the computer’s hard drive or on the
Disk On Key used for the recovery process. Back up any data on the Disk on Key or the notebook that will be
recovered before starting.
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[’_%f’ NOTE: HP recommends that you create the USB Recovery Disk in the event of a system failure. The Disk On
Key used for this process should be 4 GB or larger.

Creating a USB Recovery Disk On Key

1. Connect the USB Disk On Key to a USB port on the computer.

2. Select Computer > More applications > Tools > Create Recovery USB.
3 Enter the root password when prompted.

4. Select USB Disk On Key from the list.

5. Click OK.

6

A question dialog will remind you that the data on the USB key will be destroyed. To continue, click OK.
Otherwise, click Cancel and back up the contents of the Disk On Key on another computer.

7. The backup process will display a status dialog box while the backup is in progress.

[%f NOTE: A file browser window with the Disk On Key Contents displayed will pop up when the key is
mounted. You may close the file browser window if desired. Once the USB Recovery Key has been
created, the status dialog will close. The USB Recovery Key is ready for use.

Recovering from a USB Recovery Disk On Key

A CAUTION: Before starting the Recovery process, make sure any data on the system to be recovered has
been backed up. The recovery process destroys all data on the system to be recovered.

1. Turn off the computer.

Connect the USB Disk On Key to a USB port on the computer.

2

3.  Turnon the computer while holding down the f9 key.

4. Once the system has booted, the Boot Options menu should appear.
5

Using the arrow keys, select USB Disk On Key and press enter.

[%f NOTE: The description may vary from one USB key to another. Any entry other than Optical Disk Drive,
Notebook Hard Drive or Notebook Ethernet should be the USB Recovery Disk On Key.

6. Once the USB Recovery Disk On Key has been selected, press enter. The USB Recovery Disk On Key will
boot.

7. Once the USB Recovery Disk On Key has booted, a dialog box will prompt, “Do you want to start the
System-Restore?” If data on the computer has not been backed up, use the tab key and select No. The
system will reboot. Back up the system data and repeat the previous steps. If no data should be saved
from the computer, use the tab key to select Yes. Press enter to begin the recovery process.

8.  After the files are copied to the system, follow the on-screen instructions.

Remove everything and reinstall Ubuntu

Sometimes you want to perform detailed reformatting of your computer, or you want to remove personal
information before you give away or recycle your computer. The process described in this section provides a
speedy, simple way to return the computer to its original state. This option removes all personal data,
applications, and settings from your computer, and reinstalls the Linux operating system.

M IMPORTANT: This option does not provide backups of your information. Before using this option, back up
any personal information you wish to retain.
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You can initiate this option by using the f11 key.

To use the f11 key:

Press f11 while the computer boots.

—or-

Press and hold f11 as you press the power button.

The following options are available:

e  (Cancel/Reboot—Reboots the system. No recovery or restore activity is performed.

e  Recover/Repair System—This option repairs a system that is not working properly and preserves user
data.

e  Restore Factory System—This option restores the system back to the original factory state. User data is
not preserved.

Select an option and follow the on-screen instructions.
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16 Specifications

Computer specifications

Metric u.s.
Dimensions
Length
Non-touch 262.8 mm 10.35in
Touch 263.2 mm 10.36in
Width 375 mm 14.76in
Height (front to rear)
Non-touch 23.4t025.5mm 0.92t01.00in
Touch 25.0t027.1mm 0.98t01.07 in
Weight
Non-touchscreen (equipped with 1 DIMM, M.2 SSD, WLAN module, 2.22 kg 49lbs
webcam, 4 cell battery, optical drive)
Non-touchscreen (equipped with 1 DIMM, M.2 SSD, WLAN module, 2.11kg 4.66 lbs
webcam, 4 cell battery, no optical drive)
Non-touchscreen (equipped with 1 DIMM, hard drive, WLAN 2.31kg 5.11lbs
module, webcam, 4 cell battery, optical drive)
Non-touchscreen (equipped with 1 DIMM, hard drive, WLAN 2.20kg 4.86 lbs
module, webcam, 4 cell battery, no optical drive)
Touchscreen (equipped with 1 DIMM, hard drive, WLAN module, 2.81kg 6.19 lbs
webcam, 4 cell battery), optical drive
Touchscreen (equipped with 1 DIMM, hard drive, WLAN module, 2.70kg 5.95 lbs

webcam, 4 cell battery), no optical drive

Input power

Operating voltage 19.0Vdc@4.74A-90Wor18.5Vdc@3.5A-65W
Operating current 474A0r3.5A

Temperature

Operating (not writing to optical disc) 0°Cto 35°C 32°F to 95°F
Operating (writing to optical disc) 5°Cto 35°C 41°F to 95°F
Nonoperating -20°Cto 60°C -4°F to 140°F
Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)
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Metric u.s.

Operating (14.7 to 10.1 psia) -15mto0 3,048 m 50 ft to 10,000 ft
Nonoperating (14.7 to 4.4 psia) -15mt0 12,192 m -50 ft to 40,000 ft
Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this range
of temperatures.

39.6-cm (15.6-in) display specifications

Metric u.s.
Active diagonal size 39.6-cm 15.6-in
Resolution 1600x900 (FHD)

1368x768 (HD)
Surface treatment Anti-glare
Width 3.2mm
Brightness HD: 200:1 (typical)

FHD: 300:1 (typical)

Viewing angle SVA

Backlight LED

Pixel configuration RGB vertical stripe
Pixel pitch 0.084x.0252 mm
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Hard drive specifications

1.5-TB* 1-TB* 750-GB* 500-GB* 500-GB* 320-GB*
hybrid
Dimensions
Height 9.5mm 9.5mm 9.5mm 9.5mmor7.0 7.0mm 7.0mm
mm
Width 70 mm 70 mm 70 mm 70 mm 70 mm 70 mm
Weight 118g 115¢g 102g 101gor95g 95¢g 95¢g
Interface type SATA SATA SATA SATA SATA SATA
Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec
Security ATA security ATA security ATA security ATA security ATA security ATA security
Seek times (typical read, including setting)
Single track 2.2ms 1.4ms 1.1ms 3ms 2ms 1.1ms
Average 13 ms 10 ms 12ms 13 ms 12 ms 13 ms
Maximum 25ms 12ms 21ms 24ms 22ms 25ms
Logical blocks 2,930,277,168 1,938,921,461 1,465,149,168 1,048,576,000 976,773,168 625,141,400
Disc rotational speed 5400 rpm 5400 rpm 7200 or 5400 7200 rpm or 5400 rpm 5400 rpm
rpm 5400 rpm

Operating temperature

0°C to 60°C (32°F to 140°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive specifications may

differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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Solid-state drive specifications

120-GB* 128-GB*
Height 1.35mm 7.0 mm
Weight <10g <50g
Form factor M.2 2242-D2-B-M 2.5-inch
Transfer rate up to 540 MB/sec up to 515 MB/sec
Interface type SATA-3 SATA-3
Ready time, maximum (to not busy) 1.0ms <1.0ms
Access times, logical 0.1ms 0.1 ms
Total logical sectors 234,441,648 250,069,680
Operating temperature 0°C to 70°C (32°F to 158°F)

*1 GB =1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive specifications may

differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD+RW SuperMulti DL Drive specifications

Applicable disc Read: Write:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM, CD-  CD-R and CD-RW

ROM XA, MIXED MODE CD, CD-I, CD-I Bridge (Photo-

(D, Video CD), Multisession CD (Photo-CD, CD- DVD+R, DVD+RW, DVD-R, DVD-RW,
EXTRA, Portfolio, CD-R, CD-RW), CD-R, CD-RW, DVD-RAM

DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18), DVD-

R, DVD-RW, DVD+R, DVD+RW, DVD-RAM

Center hole diameter

1.5cm (0.59in)

Disc diameter

Standard disc

12cm (4.72in)

Mini disc

8cm (3.15in)

Disc thickness

1.2 mm (0.047 in)

Track pitch 0.74 pm

Access time cD DVD
Random <175ms <230ms
Full stroke <285ms <335ms

Audio output level

Line-out, 0.7 Vrms

Cache buffer 2MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD-ROM 10,800 KB/sec
24X CD-R 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8XDVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8XDVD-R 10,800 KB/sec
4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9)

2,700 KB/sec

5X DVD-RAM

6,750 KB/sec

Transfer mode

Multiword DMA Mode

Startup time

<15 seconds

Stop time

< 6 seconds

138 Chapter 16 Specifications



Blu-ray ROM DVD*RW SuperMulti DL Drive

Applicable disc Read: Write:
CD-DA, CD+(E)G, CD-MIDI, CDTEXT, CD- CD-R and CD-RW DVD+R, DVD+R(9), DVD
ROM, CD-ROM XA, MIXED MODE CD, CD-I, +RW, DVD-R, DVD-R(9),DVD-RW, DVD-RAM

CD-I Bridge (Photo-CD, Video CD),
Multisession CD (Photo-CD, CD-EXTRA,
Portfolio, CD-R, CD-RW), CD-R, CD-RW,
DVDROM (DVD-5, DVD-9, DVD-10,
DVD-18), DVD-R, DVD-RW, DVD+R, DVD
+RW, DVD-RAM, HD-ROM (Single Layer),
HD-ROM (Dual Layer), HD DVD-R, HD DVD-
R for Dual Layer, HD DVD-RW

Access time cD DVD HD
Random 170 ms 170 ms 230 ms
Cache buffer 8 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9)

2,700 KB/sec

5X DVD-RAM 6,750 KB/sec
1X BD-ROM 4,500 KB/sec
1X BD-R read 4,500 KB/sec

1X BD-RE read

4,500 KB/sec

Transfer mode

Multiword DMA Mode

DVD-ROM drive

Applicable disc

DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital Audio,
CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form 2), CD-R, CD-

RW, Photo CD (single and multisession), CD-Bridge

Center hole diameter

1.5cm (0.59in)

Disc diameter

Standard disc

12cm (4.72in)

Mini disc

8cm(3.15in)
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Disc thickness

1.2 mm (0.047 in)

Track pitch 0.74 pm

Access time D DVD
Random <100 ms <125ms
Full Stroke <175ms <225ms

Audio output level

Line-out, 0.7 Vrms

Cache buffer 512 KB

Data transfer rate

CD-R (24X) 3600 KB/s (150 KB/s at 1X CD rate)
CD-RW (10X) 1500 KB/s (150 KB/s at 1X CD rate)

CD-ROM (24X)

3,600 KB/sec

DVD (8X)

3600 KB/s (150 KB/s at 1X CD rate)

Multiword DMA mode 2

16.6 MB/s

Startup time

<10 seconds

Stop time

< 3 seconds

Specification information in Device Manager

Device Manager allows you to view and control the hardware attached to the computer, as well as provides

hardware specification information.

You can also add hardware or modify device configurations using Device Manager.

[%r NOTE: Windows 7 includes the User Account Control feature to improve the security of your computer. You
may be prompted for your permission or password for tasks such as installing software, running utilities, or
changing Windows settings. Refer to Windows Help and Support for more information.

After you open Device Manager, drill-down to a device and double-click it to access its properties.

To access Device Manager in Windows 8.1 :

1. From the Start screen, type control, and then select Control Panel.

2. Select System and Security, and then in the System area, click Device Manager.

A list display all the devices installed in your computer.

To access Device Manager in Windows 7:

1.  Select Start > Computer > System properties.

2. Inthe left pane, click Device Manager.
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17

Statement of Volatility

The purpose of this document is to provide general information regarding non-volatile memory in industry-
standards based HP Business Notebook PC systems and provide general instructions for restoring nonvolatile
memory that can contain personal data after the system has been powered off and the hard drive has been
removed.

HP Business Notebook PC products that use Intel®-based or AMD®-based system boards contain volatile DDR
memory. The amount of nonvolatile memory present in the system depends upon the system configuration.
Intel-based and AMD-based system boards contain nonvolatile memory subcomponents as originally shipped
from HP assuming that no subsequent modifications have been made to the system and assuming that no
applications, features, or functionality have been added to or installed on the system.

Following system shutdown and removal of all power sources from an HP Business Notebook PC system,
personal data can remain on volatile system memory (DIMMs) for a finite period of time and will also remain
in nonvolatile memory. The steps below will remove personal data from the notebook PC, including the
nonvolatile memory found in Intel-based and AMD-based system boards. Some of these steps are disclosed
in the Maintenance & Service Guides available for HP PC products available on the product support pages at

www.hp.com.

1. Follow steps (a) through (1) below to restore the nonvolatile memory that can contain personal data.
Restoring or reprogramming nonvolatile memory that does not store personal data is neither necessary
nor recommended.

a. Enter BIOS (F10) Setup by powering on the system and pressing F10 when prompted near the
bottom of the display, or press the ESC key to display the start up menu, then press F10. If the
system has a BIOS administrator password, enter the password at the prompt.

b. Select the File menu, then Restore Defaults.
¢. Select the System Configuration menu, then Restore Security Defaults.

d. If anasset or ownership tag is set, select the Security menu and scroll down to the Utilities menu.
Select System IDs, and then select the tag that has been set. Press the spacebar once to clear the
tag, then press Enter to return to the prior menu.

e. If aDriveLock password is set, select the Security menu, scroll down to DriveLock, then select
DriveLock password. Select the desired hard drive. Click Disable protection, enter the existing
master DriveLock password, then press Enter to confirm and return to the prior menu. Repeat this
procedure if more than one hard drive has a DriveLock password.

f. If an Automatic DriveLock password is set, select the Security menu, scroll down to Automatic
DriveLock, then select the desired hard drive and disable protection. Repeat this procedure if more
than one hard drive has an Automatic DriveLock password.

g. Select the File menu, then Reset BIOS Security to factory default. Click yes at the warning
message.

h. Select the File menu, then Save Changes and Exit.

i.  Reboot the system. If the system has a Trusted Platform Module (TPM) and/or fingerprint sensor,
one or two prompts will appear. One to clear the TPM and the other to Reset Fingerprint Sensor;
press F1 to accept or F2 to reject.

If the HP notebook model number ends in a ‘p’ or ‘w’ and includes Intel® Centrino with VProTM,
reboot the PC and enter BIOS Setup by pressing F10 when prompted. Select System Configuration,
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then AMT Options. Then select Unconfigure AMT on next boot. Select Save then Yes. Select the
File menu, and then select Save Changes and Exit. Reboot the system and confirm that you want
to unconfigure AMT.

j- If the optional Intel® Anti-Theft Technology (AT) was activated, contact the provider to deactivate
it.

k. If the optional Absolute® Software Computrace® management and tracking service was activated
on the notebook PC, contact the provider to deactivate it.

l.  Remove all power and system batteries for at least 24 hours.
2. Remove and retain the storage drive or clear the contents of the drive.
a. Hard Disk Drive (HDD)

Clear the HDD contents by using the HP Disk Sanitizer® utility or a third party application that,
ideally, is U.S. Department of Defense (DOD) 5220.22-M approved.

To run HP Disk Sanitizer, enter BIOS Setup by powering on the system and pressing F10 when
prompted near the bottom of the display, or press ESC to display the start up menu, then press
F10. Select the Security menu and scroll down to the Utilities menu. Select Disk Sanitizer and
select the desired drive. For a higher level of protection, select Optimum.

ﬁ/f NOTE: This process will take a long time, and the amount of time varies based on the hard drive
capacity.

b. Solid State Drive (SSD)

Clear the SSD contents by using the BIOS Setup Secure Erase command option, or by using a third
party utility designed to erase data from an SSD. To run Secure Erase, enter BIOS Setup by
powering on the system and pressing F10 when prompted near the bottom of the display. Select
the Security menu and scroll down to the Utilities menu. Select Secure Erase and select the
desired hard drive.
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Non-volatile memory usage

Non Volatile Amount Does this Does this What is the How is data input into How is this memory
Memory Type (Size) memory memory purpose of this memory? write protected?
store retain data this memory?
customer  when poweris
data? removed?
Real Time Clock 256 Bytes No Yes Stores system  Using the F10 Setup utility This memory is not
(RTC) battery dateand time  or changing the write-protected. HP
backed-up and limited Microsoft® Windows® date recommends
CMOS keyboard & time. password protecting
configuration controller the F10 Setup utility.
memory (CM0OS) data.
Controller (NIC) 64 Kbytes No Yes Store NIC Using a utility from the A utility is required to
EEPROM (not configuration NIC vendor that can be run  write data to this
customer and NIC from DOS. memory and is
accessible) firmware. available from NIC
vendor. Writing data to
thisROMin an
inappropriate manner
will render the NIC
nonfunctional.
Keyboard ROM 64 Kbytes No Yes Stores Programmed at the A utility is required for
(not firmware code  factory. Code is updated writing data to this
customer (keyboard, when the system BIOS is memory and is
accessible) mouse, & updated. available on the HP
battery website. Writing data
management). to thisROMin an
inappropriate manner
can render the PC
nonfunctional.
DIMM Serial 256 Bytes No Yes Stores Programmed by the Data cannot be written
Presence Detect per memory memory memory vendor. to this memory when
(SPD) module, module the module is installed
configuration 128 Bytes information. ina PC. The specific
data programma write protection
ble (not method varies by
customer memory vendor.
accessible)
System BIOS 4to5 Yes Yes Store system System BIOS code is A utility is required for
MBytes BIOS codeand  programmed at the writing data to this
PC factory. Code is updated memory and is
configuration when the system BIOS is available on the HP
data. updated. Configuration website. Writing data
data and settings are to thisROMin an
input using the F10 setup  inappropriate manner
utility or a custom utility.  can render the PC
nonfunctional.
Intel 1.50r Yes Yes Stores Management Engine Code  The Intel chipset is
Management SMByte Management is programmed at the configured to enforce
Engine Engine Code, factory. Code is updated HW protection to block
Firmware Settings, via Intel secure firmware all direct read/write
(present only in Provisioning update utility. Unique access to this area. An
models ending Data and iAMT  Provisioning Data can be Intel utility is required
ina‘p or‘w’ or third party entered at the factory or for updating the
with Intel data store. by an administrator using  firmware. Only
Centrino Pro the Management Engine firmware updates
technology) (MEBx) setup utility. The digitally signed by

third party data store
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contents can populated by
aremote management
console or local
applications registered by
an administrator to have
access to the space.

Intel can be applied
using this utility.

Bluetooth flash ~ 2Mbit No Yes Stores Programmed at the A utility is required for
Bluetooth factory. Tools for writing writing data to this
configuration data to this memory are memory and is made
and firmware.  not publicly available but  available through

can be obtained fromthe  newer versions of the
silicon vendor. driver if the flash
requires an upgrade.

802.11 WLAN 4kb to 8kb No Yes Stores Programmed at the A utility is required for

EEPROM configuration  factory. Tools for writing writing data to this
and calibration data to this memory are memory and is
data. not made public. typically not made

available to the public
unless a firmware
upgrade is necessary
to address a unique
issue.

Web camera 64K bit No Yes Store Web Cam  Using a utility from the A utility is required for
configuration device manufacturer that  writing data to this
and firmware.  can be run from Windows. memory and is

typically not made
available to the public
unless a firmware
upgrade is necessary
to address a unique
issue.

Fingerprint 512kByte Yes Yes Stores By enrolling in HP Only a digitally signed

reader Flash fingerprint ProtectTools Security application can make
templates. Manager. the call to write to the

flash.
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Questions and answers

1. How can the BIOS settings be restored (returned to factory settings)?
a. Turnon or restart the computer and press F10 when prompted near the bottom of the display.
b. Select File, then select Restore defaults.
¢. Follow the on-screen instructions.
d. Select File, save changes and exit, then press Enter.

2. Whatkind of configuration data is stored on the DIMM Serial Presence Detect (SPD) memory
module? How would this data be written?

The DIMM SPD memory contains information about the memory module such as size, serial number,
data width, speed/timing, voltage and thermal information. This information is written by the module
manufacturer and stored on an EEPROM. This EEPROM cannot be written to when the memory module is
installed in a PC. Third party tools do exist that can write to the EEPROM when the memory module is
not installed in a PC. There are various third party tools available to read SPD memory.

3. Does the “Firmware Hub for System BI0S” contain the BIOS program? Is this chip writable, and if so
how?

The Firmware Hub does contain the BIOS program and is writable. A utility is required to perform the
write function.

4. Insome PCsystems, the Firmware Hub for System BIOS is a flash memory chip so that updates can
be written by the customer. Is this true for these BIOS chips?

Yes, they are flash memory chips.
5. Whatis meant by “Restore the nonvolatile memory found in Intel-based system boards’?

This relates to clearing the Real Time Clock (RTC) CMOS memory that contains PC configuration data.
6. Doesresetting the CMOS configuration memory return the PC back to factory defaults?

The process of resetting the CMOS will return certain system settings to factory default but will not reset
many of the system data and configuration defaults to their factory settings. To return these system
data and configuration defaults to factory settings, refer to question and answer 1 and follow the
instructions for returning the BIOS settings to factory defaults.
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18 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to 120
volts ac, or from 220 to 240 volts ac.

The 3-conductor power cord set included with the computer meets the requirements for use in the country or
region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or region
where the computer is used.

Requirements for all countries and regions

The following requirements are applicable to all countries and regions:
e  The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

e  All power cord sets must be approved by an acceptable accredited agency responsible for evaluation in
the country or region where the power cord set will be used.

e  The power cord sets must have a minimum current capacity of 10 A and a nominal voltage rating of 125
or 250V ac, as required by the power system of each country or region.

e  The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard Sheet
(13 connector for mating with the appliance inlet on the back of the computer.

Requirements for specific countries and regions

Country/region Accredited agency Applicable note number
Argentina IRAM 1
Australia SAA 1
Austria OVE 1
Belgium CEBEC 1
Brazil ABNT 1
Canada CSA 2
Chile IMQ 1
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
India ISI 1
Israel Sli 1
Italy IMQ 1
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Country/region Accredited agency Applicable note number
Japan JIS 3
The Netherlands KEMA 1
New Zealand SANZ 1
Norway NEMKO 1
The People's Republic of China ccc 4
Saudi Arabia SASO 7
Singapore PSB 1
South Africa SABS 1
South Korea KTL 5
Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 6
Thailand TISI 1
The United Kingdom ASTA 1
The United States UL 2

1.  The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mmz2 conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

2. The flexible cord must be Type SVT/SJT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type
with a NEMA 5-15P (15 A, 125 V ac) or NEMA 6-15P (15 A, 250 V ac) configuration. CSA or C-UL mark. UL file number must be on

each element.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the Japanese
Dentori Law. The flexible cord must be Type VCTF, 3-conductor, 0.75mm2 or 1.25mm2 conductor size. The wall plug must be a
two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V ac) configuration.

4.  The flexible cord must be Type RVV, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance coupler and wall
plug) must bear the CCC certification mark.

5. The flexible cord must be Type HO5VV-F 3X0.75mm2 conductor size. KTL logo and individual approval number must be on each
element. Corset approval number and logo must be printed on a flag label.

6. The flexible cord must be Type HVCTF 3X1.25mmz2 conductor size. Power cord set fittings (appliance coupler, cable, and wall
plug) must bear the BSMI certification mark.

7. For 127V ac, the flexible cord must be Type SVT or SJT 3 x 18 AWG, with plug NEMA 5-15P (15 A, 125 V ac), with UL and CSA or C-
UL marks. For 240 V ac, the flexible cord must be Type HO5VV-F 3X0.75/1.00mm2 conductor size, with plug BS 1363/A with BSI

or ASTA marks.
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19 Recycling

Battery

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose of the
battery in general household waste. Follow the local laws and regulations in your area for battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable
batteries. For more information about recycling programs, see the HP Web site at http://www.hp.com/recycle.

Display

A WARNING! The backlight contains mercury. Exercise caution when removing and handling the backlight to
avoid damaging this component and causing exposure to the mercury.

A CAUTION: The procedures in this chapter can result in damage to display components. The only components
intended for recycling purposes are the LCD panel and the backlight. When you remove these components,
handle them carefully.

[%’/r NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly that
might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or see the
Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

9—-

[%r NOTE: The procedures provided in this chapter are general disassembly instructions. Specific details, such
as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one computer
model to another.

Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.
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2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).

4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.
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6. Remove the display panel assembly (2) from the display enclosure.

7. Position the display panel assembly upside-down.

8. Remove all screws that secure the display panel frame to the display panel.

.

9. Use asharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.

10. Remove the display panel frame (2) from the display panel.

=

=

11. Remove the screws (1) that secure the backlight cover to the display panel.
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12. Lift the top edge of the backlight cover (2) and swing it outward.

i
I
I
i -

o

13. Remove the backlight cover.
14. Position the display panel right-side up.
15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Position the display panel upside-down.

A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.
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17. Remove the backlight frame from the display panel.

__,._,._,._,.

18. Remove the backlight from the backlight frame.

19.
20.
21.
22.

Disconnect the display panel cable (1) from the LCD panel.

Remove the screws (2) that secure the LCD panel to the display rear panel.
Release the LCD panel (3) from the display rear panel.

Release the tape (4) that secures the LCD panel to the display rear panel.
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23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Index

A
AC adapter, spare part numbers 27
AC adapter/battery light 16
antennas
disconnecting 45,47
audio, product description 4
audio-in (microphone) jack,
identifying 17
audio-out (headphone) jack,
identifying 17

B
backup 130
Backup and Restore 118
backup tools 116
backups 124
creating 117
recovering 118
base enclosure, spare part number
23
battery
spare part number 23,36
battery bay, identifying 15
battery connector cable
removal 77
spare part number 77
battery connector cable, illustrated
26
battery lock latch 15
battery release latch 14

BIOS
determining version 97,102,
108,112
downloading an update 98, 103,
108,113

updating 97,102,108, 112
Blu-ray ROM DVD+RW SuperMulti
specifications 139
Blu-ray ROM DVD+RW SuperMulti DL
Drive, spare part number 24, 27,
43
Bluetooth card
spare part number 45
Bluetooth label 18

154 Index

boot order
changing 128
bottom 18
buttons
left TouchPad 10
optical drive eject 17
power 12
right TouchPad 10

C
Cable Kit

contents 26

spare part number 26
cables, service considerations 31
caps lock light, identifying 11
card reader board

removal 69

spare part number 21,69
case, spare part number 29
chipset, product description 2
components

bottom 14

display 9

front 15

leftside 16

right side 17

top 10
computer reset 132
Computer Setup

navigating and selecting 96,

101,106, 111
restoring factory settings 97,
102,107,112

computer setup

navigating and selecting 111

restoring factory settings 112
computer specifications 134
connector, power 16
connectors, service considerations

31

D
diskette drive
precautions 31

display assembly
removal 88
removing 54
spare part numbers 88
display assembly subcomponents
removing 54
display bezel
removal 54,90
removing 54
spare part numbers 25
display component recycling 148
display components, spare part
numbers 25
display hinge
removal 56,92
Display Hinge Kit
spare part numbers 26
display panel
product description 2
display rear cover
spare part number 26
display specifications 135
Driver Recovery DVD,
creating 116
using for restore 119
drives
preventing damage 31
DVD-ROM drive, spare part number
24, 27,43
DVD-ROM drive, specifications 139
DVD+RW SuperMulti DL Drive
specifications 138
DVDxRW SuperMulti DL Drive, spare
part number 24,27,43

E

electrostatic discharge 32

esc key, identifying 13

Ethernet, product description 4
expansion base, spare part number
29

external media cards, product
description 5

external monitor port 16



F
f11 recovery
fan
removing 75
spare part number 23
fingerprint reader
identifying 13
fingerprint reader assembly
removal 64
spare part number
fn key, identifying 13
function board
removal 67
spare part number 21, 67
function keys, identifying 13

119,122

21,64

G

graphics, product description 2

grounding equipment and methods
34

H
hard drive
precautions 31
product description 3
removing 39
spare part numbers 23, 27, 39
specifications 136
Hard Drive Hardware Kit, spare part
number 27
hard drive light 15
hard drive recovery 119, 122
hard drive, identifying 14
HDMI port
identifying 16
headphone (audio-out) jack 17
heat sink
removal 85
spare part number
heat sink assembly
spare part number
hinge
removal 56,92
HP PC Hardware Diagnostics (UEFI)
using 114
HP Recovery Disc Creator, using 116
HP Recovery Manager
correcting boot problems 128
starting 127

23,85

23,85

HP Recovery media
creating 124
recovery 127
HP Recovery partition
checking for presence 119
recovery 127
removing 129
using for recovery 119

|

integrated numeric keypad,
identifying 14

integrated webcam light,
identifying 9

internal display switch 9

internal microphones, identifying 9

J

jacks
audio-in (microphone) 17
audio-out (headphone) 17
network 16
RJ-45 (network) 16

K
keyboard
product description 5
removal 49
spare part numbers 21, 49
keypad
integrated numeric 14
keys
esc 13
fn 13
function 13

Windows key 13

L
labels
Bluetooth 18
regulatory 18
serial number 18
service 18
wireless certification 18
WLAN 18
latch, battery lock 15
latch, battery release 14
legacy support, USB 96, 101, 106,
111
lights
AC adapter/battery 16

caps lock 11

hard drive 15
microphone mute 11
numlock 11

power 11

RJ-45 (network) 16
TouchPad 11
webcam 9

wireless 11

M
mass storage devices, spare part
numbers 27
memory card reader, identifying 15
memory module
identifying 14
product description 3
removal 41
spare part numbers 22, 41
microphone (audio-in) jack
product description 4
microphone (audio-in) jack,
identifying 17
microphone module
spare part number 25
microphone mute light, identifying
11
minimized image recovery 127
minimized image, creating 126
model name 1
mouse, spare part number 29

N
network jack, identifying 16
num lock light 11

0
operating system, product
description 6
optical drive
precautions 31
product description 4
removal 43
spare part numbers 24, 27,43
specifications 138, 139
optical drive eject button,
identifying 17
optical drive extension board
removal 82
spare part number 22, 82
optical drive, identifying 17
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original system recovery 126

P
packing guidelines 33
plastic parts 30
pointing device, product
description 5
ports
external monitor 16
HDMI 16
product description 5
usB 17
power button
identifying 12
power button board assembly
removal 65
spare part number 21, 65
power cable
removal 95
spare part number 23, 95
power connector, identifying 16
power cord
set requirements 146
spare part numbers 27, 28
power lights 11
power requirements, product
description 6
processor
product description 1
product description
audio 4
chipset 2
display panel 2
Ethernet 4
external media cards 5
graphics 2
hard drives 3
keyboard 5
memory module 3
microphone 4
operating system 6
optical drives 4
pointing devices 5
ports 5
power requirements 6
processors 1
product name 1
security 6
serviceability 8
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webcam 4
wireless 4
product name 1
product name and number,
computer 18

R
recover
options 126
recovery 123,130
discs 125,127
HP Recovery Manager 126
media 127
starting 127
supported discs 125
system 126
USB flash drive 127
using HP Recovery media 125
recovery media
creating 116,124
creating using HP Recovery
Manager 125
using for restore 119
recovery partition 119,122
removing 129
recovery tools 116
recovery tools, Windows 118
recovery, system 118
refresh 123
regulatory information
regulatory label 18
wireless certification labels 18
removal/replacement
preliminaries 30
procedures, Authorized Service
Provider 53
procedures, Customer Self-
Repair 35
reset 123
computer 132
steps 132
restoring the hard drive 119, 122

RJ-45 (network) jack, identifying 16

RJ-45 (network) lights, identifying
16
RTC battery
spare part number 22
RTC battery, HP 450 models
removal 83
spare part number 83

RTC battery, HP 455 models
removal 61
spare part number 61

S
Screw Kit, spare part number 29
security cable slot, identifying 17
security, product description 6
serial number 18
serial number, computer 18
service considerations 30
service door

spare part number 23,37
service labels, locating 18

serviceability, product description 8

setup utility
navigating and selecting 96,
101, 106
restoring factory settings 97,
102,107
SIM slot, identifying 15

slots
security cable 17
SIM 15

solid-state drive

spare part numbers 23, 27

specifications 137
speaker assembly

removal 62

spare part number 23,62
speakers, identifying 13
specifications

Blu-ray ROM DVD+RW

SuperMulti 139

computer 134

display 135

DVD-ROMdrive 139

DVD+RW SuperMulti DL Drive

138

hard drive 136

optical drive 138,139

solid-state drive 137
Startup Repair, using 118
static-shielding materials 34
supported discs, recovery 125
Sure Start

using 110
system board

removal 78

spare part numbers 21,78



systemrecovery 126
system restore point
creating 125
system restore point, creating 124

T
thermal material, replacement 86,
87

tools required 30
top cover

removal 58

spare part number 21,58
TouchPad

buttons 10
touchpad button board

removal 73

spare part number 21,73
TouchPad light, identifying 11
TouchPad zone

identifying 10
TPM settings 109
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